CAMEDIA
DIGITAL CAMERA
C-60 ZOOM
REFERENCE MANUAL

<Click Here>

CAMERA OPERATION MANUAL
Explanation of digital camera functions and operating instructions.

DIGITAL CAMERA - PC CONNECTION OPERATION MANUAL
Explanation of how to download images between your digital camera and PC.
Thank you for purchasing an Olympus digital camera. Before you start to use your new camera, please read these instructions carefully to enjoy optimum performance and a longer service life. Keep this manual in a safe place for future reference.

- We recommend that you take test shots to get accustomed to your camera before taking important photographs.
- The images and illustrations in this manual may differ from their real versions.
For customers in North and South America

For customers in USA

Declaration of Conformity

Model Number : C-60 ZOOM
     RM-2 (Remote control)
Trade Name : OLYMPUS
Responsible Party : Olympus America Inc.
Address : 2 Corporate Center Drive, Melville, New York
     11747-3157 U.S.A.
Telephone Number : 1-631-844-5000

Tested To Comply With FCC Standards
FOR HOME OR OFFICE USE

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference that may cause undesired operation.

For customers in Canada

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

For customers in Europe

“CE” mark indicates that this product complies with the European requirements for safety, health, environment and customer protection.
“CE” mark cameras are intended for sales in Europe.

Trademarks

• IBM is a registered trademark of International Business Machines Corporation.
• Microsoft and Windows are registered trademarks of Microsoft Corporation.
• Macintosh is a trademark of Apple Computer Inc.
• All other company and product names are registered trademarks and/or trademarks of their respective owners.
• The standards for camera file systems referred to in this manual are the “Design Rule for Camera File System/DCF” standards stipulated by the Japan Electronics and Information Technology Industries Association (JEITA).
## Composition of the manual

<table>
<thead>
<tr>
<th>Contents</th>
<th>P. 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names of parts</td>
<td>P. 8</td>
</tr>
</tbody>
</table>

### Introduction to the camera's functions
1. Getting started | P. 15
2. Using the menus | P. 27

### Basic photography
3. Shooting basics | P. 35

### Find out how to adjust settings manually for more creative control
4. Advanced shooting | P. 58
5. Adjusting the image quality and exposure | P. 79

### Playing back and editing pictures
6. Playback | P. 89

### Settings that make the camera easier to operate
7. Useful functions | P. 103

### Printing pictures
8. Print setting (DPOF) | P. 125
9. Direct printing (PictBridge) | P. 129

### Troubleshooting and other information
10. Miscellaneous | P. 143

### Specifications
- P. 163

### Glossary
- P. 165

### Index
- P. 168
Contents

Composition of the manual .................................................. 3
Names of parts ................................................................. 8
Monitor indications ............................................................ 10
  Memory gauge ............................................................... 13
  Battery check ............................................................... 13
How to use this manual .................................................... 14

1 Getting started .............................................................. 15
Attaching the strap ........................................................... 15
Battery/Card basics .......................................................... 16
  Battery basics ............................................................. 16
  Card basics ............................................................... 17
  Loading/Unloading the battery/card .................................. 18
  Using an optional AC adapter ......................................... 20
Power on/off ................................................................. 21
  Shooting mode ......................................................... 21
  Playback mode ......................................................... 21
  Startup/Shutdown screen ............................................... 22
  If the card is not recognized (Card check) ......................... 23
Date/time setting 专卖店 .................................................. 24
Language selection ........................................................ 26

2 Using the menus ........................................................... 27
What are the menus? ....................................................... 27
How to use the menus .................................................... 28
Shortcut menus (shooting/playback) ................................... 30
MODE MENU (shooting) .................................................. 31
MODE MENU (playback) ................................................ 33

3 Shooting basics ........................................................... 35
Shooting modes ............................................................. 35
Holding the camera ......................................................... 39
How to press the shutter button ........................................ 40
Taking still pictures ......................................................... 41
  Taking still pictures using the monitor ............................... 41
  Taking still pictures using the viewfinder ........................... 42
  Comparison of the monitor & viewfinder ............................ 44
  How to turn off the monitor ........................................... 45
Contents

If correct focus cannot be obtained ........................................... 46
  Determine the position of the subject after focusing (Focus Lock) .... 46
  When Auto focus does not work
    (Subjects that are difficult to focus on) ................................. 48

Movie recording ☞ ................................................................. 49

Zoom .................................................................................. 51
  Using the optical zoom .......................................................... 51
  DIGITAL ZOOM — Using the digital zoom .............................. 52

Flash shooting ........................................................................ 53
  Using the flash ..................................................................... 55
  Flash intensity control ............................................................ 57

4 Advanced shooting ......................................................... 58

Aperture priority shooting A .................................................. 58
Shutter priority shooting S ..................................................... 59
Manual shooting M ................................................................. 60
FULLTIME AF — A reliable time-saving way to focus .................. 61

Selecting the metering area .................................................... 62

Macro mode shooting — Taking close-up pictures .................... 63

Super macro shooting ✽ .......................................................... 64

Self-timer shooting ☺ ............................................................ 65
Remote control shooting ......................................................... 66

Sequential shooting ☞ AF BKT .................................................. 68
  Sequential shooting & AF sequential shooting ☞ AF .................. 68
  Auto bracketing — Shooting pictures sequentially with a different exposure for each frame BKT ....................... 69

Panorama shooting ................................................................ 71
Taking two-in-one pictures 2 IN 1 ............................................ 73

FUNCTION — Adding special effects to pictures ...................... 74

Recording sound with still pictures ......................................... 75
Recording sound with movies ................................................... 77
Using the optional accessories ................................................. 78
<table>
<thead>
<tr>
<th>5 Adjusting the image quality and exposure</th>
<th>79</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record mode</td>
<td>79</td>
</tr>
<tr>
<td>Selecting still picture record modes</td>
<td>81</td>
</tr>
<tr>
<td>Selecting movie record modes</td>
<td>82</td>
</tr>
<tr>
<td>ISO sensitivity</td>
<td>83</td>
</tr>
<tr>
<td>Exposure</td>
<td>84</td>
</tr>
<tr>
<td>White balance <strong>WB</strong></td>
<td>85</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>86</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>87</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>88</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6 Playback</th>
<th>89</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing still pictures.</td>
<td>89</td>
</tr>
<tr>
<td>Close-up playback</td>
<td>90</td>
</tr>
<tr>
<td>Index display</td>
<td>91</td>
</tr>
<tr>
<td>Selecting the number of pictures</td>
<td>91</td>
</tr>
<tr>
<td>Slideshow</td>
<td>92</td>
</tr>
<tr>
<td>Picture rotation</td>
<td>93</td>
</tr>
<tr>
<td>Viewing movies</td>
<td>94</td>
</tr>
<tr>
<td>INDEX — Creating an index</td>
<td>96</td>
</tr>
<tr>
<td>Playback on a TV</td>
<td>97</td>
</tr>
<tr>
<td>Recording sound</td>
<td>98</td>
</tr>
<tr>
<td>Editing still pictures</td>
<td>99</td>
</tr>
<tr>
<td>Protecting pictures</td>
<td>100</td>
</tr>
<tr>
<td>Erasing pictures</td>
<td>101</td>
</tr>
<tr>
<td>Single-frame erase</td>
<td>101</td>
</tr>
<tr>
<td>All-frame erase</td>
<td>102</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>7 Useful functions</th>
<th>103</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET — Saving the camera’s settings</td>
<td>103</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>105</td>
</tr>
<tr>
<td>Registering functions to the shortcut menus</td>
<td>106</td>
</tr>
<tr>
<td>Using the shortcut menu</td>
<td>107</td>
</tr>
<tr>
<td>MY MODE SETUP — Registering customized settings</td>
<td>108</td>
</tr>
<tr>
<td>in the mode</td>
<td>108</td>
</tr>
<tr>
<td>INFO — Displaying shooting information on the monitor</td>
<td>INFO</td>
</tr>
<tr>
<td>Histogram display — Displaying the brightness</td>
<td>distribution of still pictures</td>
</tr>
</tbody>
</table>
Contents

CARD SETUP — Formatting cards .......................... 115
Monitor brightness adjustment .............................. 117
Beep — Setting the warning tone .......................... 117
SHUTTER SOUND — Setting the shutter sound ............. 118
VOLUME — Adjusting the playback volume .................. 119
PW ON/OFF SETUP — Power on/off display/          
    sound volume setting .................................. 120
REC VIEW — Checking the picture immediately after shooting 121
SLEEP — Sleep timer ........................................ 122
VIDEO OUT — Selecting the video signal type ............... 122
FILE NAME — Assigning a file name ....................... 123
PIXEL MAPPING — Checking the image processing functions 124

8 Print setting (DPOF) ..... 125
How to print pictures ...................................... 125
Applying print reservation to a card ........................ 127

9 Direct printing (PictBridge) ..... 129
Using the direct printing function ......................... 129
Connecting the camera to a printer ....................... 130
Printing pictures ............................................ 131
    Printing basics ........................................ 132
    PRINT mode/MULTI PRINT mode ....................... 133
    ALL PRINT mode ....................................... 137
    ALL INDEX mode/PRINT ORDER mode ................ 139
Exiting direct printing .................................. 141
If an error code is displayed ............................ 142

10 Miscellaneous ............................................ 143
Error codes ................................................. 143
Troubleshooting ............................................ 145
Menu directory ............................................. 154
Camera maintenance ....................................... 161
    How to replace the battery (CR2025) of the remote control device 162
Specifications ................................................ 163
Glossary ..................................................... 165
Index ......................................................... 168
Names of parts

- **Flash**: P. 53
- **Self-timer/Remote control lamp**: P. 65, 66
- **Microphone**: P. 75, 77, 98
- **AF sensor**
- **Lens barrier**
- **Remote control receiver**: P. 66
- **Strap eyelet**: P. 15
- **Lens**
- **Speaker**
- **Power lamp**: P. 21
- **Zoom lever (W / T Q)**: P. 51, 90, 91
- **Shutter button**: P. 40
- **Mode dial**: P. 35
Green lamp  P. 40
Orange lamp  P. 40, 55
Viewfinder  P. 42

(Flash mode) button  P. 55
(Erase) button  P. 101
(Macro/Spot) button  P. 62, 63
(Protect) button  P. 100

(Playback) button  P. 21, 89

AF target mark  P. 41, 46
Monitor  P. 10, 41, 117

Card access lamp  P. 40, 41

OK/Menu button ( )  P. 27

DC-IN jack  P. 20

A/V OUT jack (MONO)  P. 97

USB connector  P. 130

Battery/Card compartment cover  P. 18

Connector cover  P. 20, 97

Tripod socket
Monitor indications

● Indications during shooting

1. 1/800  F2.8  +0.3
2. HQ  2816x2112
3. P
4. 100-0015  100-0015
5. ISO 100
6. 04.07.01  16:00
7. 00:00/00:20
8. +0.3
9. WB AUTO

When INFO is set to OFF

When INFO is set to ON

● Indications during still picture playback

10. 1/800  F2.8  +0.3
11. HQ  2816x2112
12. 100-0018
13. ISO 100
14. 04.07.01  12:30
15. 00:00/00:20
16. +0.3
17. WB AUTO

When INFO is set to OFF

When INFO is set to ON

● Indications during movie playback

31. 100-0015
32. HQ
33. 04.07.01  16:00
34. 00:00/00:20
35. +0.3
36. WB AUTO

When INFO is set to OFF

When INFO is set to ON
<table>
<thead>
<tr>
<th>Items</th>
<th>Indications</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Shooting mode</td>
<td>AUTO, P, A, S, M, <img src="image" alt="mode" /></td>
<td>P. 35</td>
</tr>
<tr>
<td>2 Shutter speed</td>
<td>8 to 1/1000</td>
<td>P. 59</td>
</tr>
<tr>
<td>3 Aperture value</td>
<td>F2.8 to F8.0</td>
<td>P. 58</td>
</tr>
<tr>
<td>4 Exposure compensation</td>
<td>–2.0 to +2.0</td>
<td>P. 84</td>
</tr>
<tr>
<td>Exposure differential</td>
<td>–3.0 to +3.0</td>
<td>P. 60</td>
</tr>
<tr>
<td>5 AF target mark</td>
<td><img src="image" alt="AF target" /></td>
<td>P. 41</td>
</tr>
<tr>
<td>6 Record mode</td>
<td>TIFF, SHQ, HQ, SQ1, SQ2</td>
<td>P. 79</td>
</tr>
<tr>
<td>7 Resolution</td>
<td>2816 x 2112, 2560 x 1920, 1600 x 1200, etc.</td>
<td>P. 79</td>
</tr>
<tr>
<td>8 Number of storable still pictures/</td>
<td>24 (still pictures)</td>
<td>P. 80</td>
</tr>
<tr>
<td>Remaining recording time</td>
<td>00:24 (min.: sec.) (movies)</td>
<td>P. 49</td>
</tr>
<tr>
<td>9 Memory gauge</td>
<td><img src="image" alt="memory" /></td>
<td>P. 13</td>
</tr>
<tr>
<td>10 Battery check</td>
<td><img src="image" alt="battery" /></td>
<td>P. 13</td>
</tr>
<tr>
<td>11 Noise reduction</td>
<td><img src="image" alt="NR" /></td>
<td>P. 88</td>
</tr>
<tr>
<td>12 Flash stand-by mark</td>
<td><img src="image" alt="flash" /></td>
<td>P. 55</td>
</tr>
<tr>
<td>13 Green lamp</td>
<td><img src="image" alt="green lamp" /></td>
<td>P. 40</td>
</tr>
<tr>
<td>14 Macro mode/ Super macro mode</td>
<td><img src="image" alt="macro" /></td>
<td>P. 63, 64</td>
</tr>
<tr>
<td>15 Flash mode</td>
<td><img src="image" alt="flash" />, <img src="image" alt="SLOW" /></td>
<td>P. 53</td>
</tr>
<tr>
<td>16 Flash intensity control</td>
<td><img src="image" alt="flash intensity" /> –2.0 to +2.0</td>
<td>P. 57</td>
</tr>
<tr>
<td>17 Drive mode</td>
<td><img src="image" alt="drive" />, AF, BKT</td>
<td>P. 68</td>
</tr>
<tr>
<td>18 Self-timer/ Remote control</td>
<td><img src="image" alt="self-timer" />, AF, BKT</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>19 Sound record</td>
<td><img src="image" alt="sound" /></td>
<td>P. 75, 77</td>
</tr>
<tr>
<td>20 Spot metering</td>
<td><img src="image" alt="spot metering" /></td>
<td>P. 62</td>
</tr>
</tbody>
</table>
### Monitor indications

<table>
<thead>
<tr>
<th>Items</th>
<th>Indications</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>21 ISO</td>
<td>ISO64, ISO100, ISO200, ISO400</td>
<td>P. 83</td>
</tr>
<tr>
<td>22 White balance</td>
<td>☀, ☀, ☀, ☀</td>
<td>P. 85</td>
</tr>
<tr>
<td>23 Print reservation</td>
<td>☑</td>
<td>P. 127</td>
</tr>
<tr>
<td>24 Number of prints</td>
<td>x2 to x10</td>
<td>P. 128</td>
</tr>
<tr>
<td>25 Protect</td>
<td></td>
<td>P. 100</td>
</tr>
<tr>
<td>26 File number</td>
<td>☊ 100-0018</td>
<td>—</td>
</tr>
<tr>
<td>27 Date</td>
<td>’04.07.01</td>
<td>P. 24</td>
</tr>
<tr>
<td>28 Time</td>
<td>07:15, 12:30, 17:45</td>
<td>P. 24</td>
</tr>
<tr>
<td>29 Frame number</td>
<td>18</td>
<td>—</td>
</tr>
<tr>
<td>30 Sound record</td>
<td>☽</td>
<td>P. 98</td>
</tr>
<tr>
<td>31 Movie</td>
<td></td>
<td>P. 94</td>
</tr>
<tr>
<td>32 Movie playback time</td>
<td>00:00/00:20, 00:00/00:20</td>
<td>—</td>
</tr>
</tbody>
</table>

- **Note**
  - The monitor indications differ depending on the camera’s settings.
  - You can select the amount of information displayed on the monitor.
  - “INFO — Displaying shooting information on the monitor” (P. 111)
Monitor indications

The memory gauge lights up when the camera is storing a still picture you have just taken on the card. The memory gauge indication changes as shown below depending on the shooting status. The memory gauge does not appear during movie recording.

**Memory gauge**

The memory gauge lights up when the camera is storing a still picture you have just taken on the card. The memory gauge indication changes as shown below depending on the shooting status. The memory gauge does not appear during movie recording.

**When taking still pictures**

- Before shooting (Gauge is off)
- Shoot
- Wait
- One picture (Lit)
- Shoot
- Wait
- No more pictures can be taken (Fully lit). Wait until the gauge returns to the status on the left to take the next shot.

**Battery check**

If the remaining battery power is low, the battery check indication changes as follows when the camera is turned on or while the camera is in use.

- Lights (green)
  - Remaining power level: High*
- Lights (red)
  - Remaining power level: Low.
  - If you intend to use the camera for a long period of time, charge the battery as soon as possible.
- No indication
  - The green lamp and orange lamp next to the viewfinder blink.
  - Remaining power level: Exhausted. Replace with a charged battery.

* Your digital camera’s power consumption varies greatly depending on usage and operating conditions. Under some operating conditions, the camera may turn off without warning that battery power is low. If this occurs, re-charge the battery.
Sets the camera to any of the modes shown.

**Panorama shooting**

You can take advantage of panorama shooting with an Olympus xD-Picture Card. Panorama shooting lets you connect images with overlapping edges into a single panoramic image, using CAMEDIA Master software (contained on the provided CD-ROM).

1. In the top menu, select MODE MENU → CAMERA → PANORAMA. Press .

2. On the monitor, use the arrow pad to choose the direction you want the pictures connected.
   - : Connects the pictures from left to right.
   - : Connects the pictures from right to left.

You can take advantage of panorama shooting with an Olympus xD-Picture Card. Panorama shooting lets you connect images with overlapping edges into a single panoramic image, using CAMEDIA Master software (contained on the provided CD-ROM).

### Available modes

- ****
- ****
- ****
- **P**

Step through the menus in the order of the arrows (P. 27)

This represents the arrow pad. Only arrows applicable to the operation are shown.

### Indications used in this manual

- ! **Note**
  - Important information on factors that may lead to a malfunction or operational problem. Also warns of operations that should be absolutely avoided.

- ?
  - Useful information and hints that will help you get the most out of your camera.

- Reference pages describing details or associated information.
1 Attaching the strap

1 Thread the end (small loop) of the strap through the strap eyelet.

2 Thread the rest of the strap through the small loop that you threaded through the eyelet.

3 Pull on the strap to make sure it is securely fastened.

Note

- Be careful with the strap when you carry the camera, as the strap can easily catch on stray objects, causing serious damage.
- Attach the strap correctly as shown so that the camera does not fall off. If the strap is attached incorrectly and the camera falls off the strap, Olympus is not responsible for any damages.
Battery/Card basics

Battery basics

This camera uses an Olympus lithium ion battery (LI-10B/12B). This battery is dedicated to this camera and other batteries do not work. The battery is not fully charged when the camera is purchased. Fully charge the battery on the specified charger (LI-10C) before first use. Do not use any other chargers. For details, read the charger’s instructions (provided).

- Charging of the battery usually takes 2 hours. Charging may be completed quickly depending on how much battery power remains.
- If the charging indicator blinks red, this may indicate that the battery is not properly attached or that the battery has malfunctioned.
- Charging of the battery may cause noise on a television or radio sharing the same wall outlet; however, this is not a malfunction. If this should happen, plug the battery charger into a separate wall outlet.
- The battery may become hot during charging; however, this does not indicate a malfunction.
- This battery charger is guaranteed to operate within an ambient temperature range of 0°C to 40°C. To ensure maximum performance of the battery charger, however, you are recommended to use it between 10°C and 30°C.
- When using the battery charger in a foreign country, be sure to use a travel converter that matches the wall outlet in the area the camera is being used. Please consult a travel agency for more information on travel converters.
Card basics

“Card” in this manual refers to the xD-Picture Card. The camera uses the card to record pictures. The card corresponds to normal camera film for recording the pictures you have taken. Pictures recorded and stored on the card can easily be erased, overwritten, and/or edited on a PC. The following cards can be used: Read the instructions for the card carefully before use.

Compatible xD-Picture Card: xD-Picture Card (16 to 512 MB)

Note

- This camera may not recognize a non-Olympus card or a card that was formatted on another device (such as a computer). Before use, be sure to format the card on this camera.
  “Formatting cards” (P. 115)
- Do not place a sticker or label on the card as this could prevent the card from being ejected.
Loading/Unloading the battery/card

1 Make sure the camera is turned off:
   - The lens barrier is closed.
   - The monitor is turned off.
   - The green lamp is off.
   - The power lamp is off.

2 Slide the battery/card compartment cover in the direction of the arrow A.
   - The battery/card compartment cover unlocks and opens in the direction of the arrow B.
   - Use the ball of your finger to slide the cover. Do not use your fingernail as this could result in injury.

3 Loading the battery
   Insert the battery in the correct direction in the battery/card compartment.
   - Make sure the knob is locked securely. If the knob is not locked, the battery may pop out when opening the battery/card compartment cover.

   Unloading the battery
   Slide the knob in the direction of the arrow. The battery pops out. Remove it.
Battery/Card basics

Getting started

Loading the card
Face the card the correct way and insert it into the battery/card compartment.
- Insert the card while keeping it straight.
- Inserting the card the wrong way or at an angle could damage the contact area or cause the card to jam.
- If the card is not inserted all the way, data may not be written to the card.

Unloading the card
Push the card all the way in to unlock it, then let it return slowly.
- The card is ejected a short way and then stops. Hold the card straight and pull it out.

4 Close the battery/card compartment cover in the direction of the arrow C, then slide it in the direction of the arrow D.

Note
- If the battery is removed within 3 seconds after the power is turned off, the settings saved in the mode may be canceled.
- Power is consumed continuously during the conditions described below. This could affect the number of storable pictures or remaining recording time.
  - When the monitor is turned on.
  - Repeated auto-focus by pressing the shutter button halfway.
  - Repeated power zoom adjustments.
  - When the camera is connected to a computer or printer.

- Do not press on the card with hard or pointed items such as ballpoint pens.
- Never open the battery/card compartment cover or disconnect the optional AC adapter while the camera is turned on. Doing so could destroy all data on the card. Destroyed data cannot be restored.
- The card may eject forcibly if you take your finger off the card immediately after pushing it.
Using an optional AC adapter

In addition to the provided battery, an optional Olympus CAMEDIA-brand AC adapter can be used.

An AC adapter is useful when performing time-consuming tasks such as downloading images to a computer. Use an AC adapter designed to operate on the AC voltage in the region the camera is being used. Consult your nearest Olympus dealer or service center for details.

- Before using the AC adapter, remove the battery from the camera.
- If the battery power runs out while the camera is connected to a computer, image data may be corrupted. It is recommended that you use the optional AC adapter when transferring images to a computer. Do not disconnect or connect the AC adapter while the camera is communicating with the computer.
- Do not remove or load the battery and/or do not disconnect or connect the AC adapter while the camera is turned on. Doing so could damage the camera’s settings or functions.
- Carefully read the “Safety Precautions” included in the package before use.

Note
Power on/off

Shooting mode

**Power on:** Open the lens barrier. The monitor turns on. The camera turns on in the shooting mode (the power lamp lights).

**Power off:** Partly close the lens barrier to turn the camera off (about halfway across the lens). Wait until the monitor turns off and the lens is fully retracted. Close the lens barrier all the way. The camera turns off (the power lamp turns off).

**Turning the camera on:**
Open the lens barrier.

**Turning the camera off:**
Close the lens barrier.

Playback mode

**Power on:** Press the (playback) button with the lens barrier closed. The camera turns on in the playback mode (the monitor turns on).

**Power off:** Press . The camera turns off (the monitor turns off).

**Turning the camera on:**
Press the button.

**Turning the camera off:**
Press the button.
• The camera automatically enters the sleep mode* to save power when the power is left on and no operations are performed. The camera activates again as soon as you operate any button. Sleep time interval can be set. \( \text{P. 122} \)
  * In the playback mode, the camera always turns off if no operation is performed for 3 minutes regardless of the sleep mode setting.

• The power lamp stays lit in the following cases:
  – When the camera is connected to a computer.
  – When the camera is in the sleep mode.

• When closing the lens barrier, do not push the lens barrier against the lens. Forcing the lens barrier may damage the camera body or cause a malfunction.

**Note**

**Startup/Shutdown screen**

You can select whether to display the startup/shutdown screen or adjust the sound volume when the power is turned on/off.

\( \text{P. 120} \)
If the card is not recognized (Card check)

When the power is turned on, the camera checks the card automatically. If there is no card in the camera or a card that is not supported by this camera is inserted, the following screen is displayed.

<table>
<thead>
<tr>
<th>Indications</th>
<th>TIPS</th>
</tr>
</thead>
</table>
| ![NO CARD icon] | There is no card in the camera or the card is not locked into place.  
→ Insert a card. If a card is already inserted, remove it and insert it again. |
| ![CARD ERROR icon] | There is a problem with the card.  
→ Format the card, if this does not correct the problem, use a different card. |
| ![CARD SETUP screen] | The card cannot be recognized with this camera system.  
→ Press  to select POWER OFF, then press . Replace the card with a new one.  
→ Format the card.  
① Press  to select FORMAT, then press .  
The FORMAT screen appears.  
② Press  to select YES, then press  to start formatting.  
When formatting is complete, the camera is ready for shooting. |

- All data stored on the card is erased when the card is formatted.

Note
Getting started

1

Set the mode dial to **AUTO**, then open the lens barrier.

- The power lamp lights and the lens extends.
- If the lens does not extend, the lens barrier is not fully open.
- The monitor turns on automatically.

2

Press **.**

- The top menu appears.

3

Press **on the arrow pad to select **.

4

When **** is selected on the screen, press **** to select the date format.

- Select any one of the following formats:
  - D-M-Y (Day/Month/Year)
  - M-D-Y (Month/Day/Year)
  - Y-M-D (Year/Month/Day)
- The following instructions show the procedure used when the date and time settings are set to Y-M-D.

Set the date/time. Because the date and time are saved with the recorded pictures, be sure to set them correctly.
5 Press to move to the year setting.

6 Press to set the year. When the year is set, press to move to the month setting.
   ● Repeat this procedure until the date and time are completely set.
   ● To move back to the previous setting, press .
   ● The camera can only display the time in “number of hours”, or what is commonly known as military time. Consequently, 2 p.m. would be 14:00 hours, or 12:00 hours + 2:00 hours = 14:00 hours.
   ● The first two digits of the year cannot be changed.

7 Press .
   ● For a more accurate setting, press when the clock hits 00 seconds. The clock starts when you press the button.

8 To turn the camera off, close the lens barrier.

Note
- The current settings remain the same even when the power is turned off, unless they are readjusted.
- The date setting will return to the factory default setting if the camera is left with no battery for approximately one day. If this happens, you will need to set the date again. The setting will be canceled more quickly if the battery was only loaded in the camera for a short time before being removed.
Language selection

You can select a language for on-screen display. Available languages vary depending on the area where you purchased this camera. This reference manual shows the English on-screen display in the illustrations and explanations.

1 Open the lens barrier.
   • Set the mode dial to any mode except AUTO.

2 Press .
   • The top menu is displayed.

3 Press on the arrow pad to select MODE MENU.

4 Press to select the SETUP tab, then press .

5 Press to select , then press .

6 Press to select a language, then press .

7 Press again to exit the menu.

8 To turn the camera off, close the lens barrier.
What are the menus?

When you turn on the camera and press 📷, the top menu is displayed on the monitor. You can make a variety of function settings on this camera using the menus. This chapter explains how the menus work, using the P mode screens.

Shortcuts menus
- Take you directly to the setting screens.
- Display operational buttons at the bottom of the screen.
- You can change the shortcut menus in any mode other than AUTO, ⬠ and ⚪ modes.

"SHORT CUT" (P. 105)

Top menu
- Press the arrow pad to display the shortcut menus or MODE MENU.

MODE MENU
- Lets you access various menu functions such as the ISO value, etc.
- Categorizes the functions under 4 tabs (CAMERA, PICTURE, CARD and SETUP).
- Displays the associated menu items when you press ⬠ to select a tab.
How to use the menus

The instructions below show how to use the menus using the P mode screen.

1. Press \( \text{\textparagraph} \) to display the top menu. Press \( \text{\textparagraph} \).

Top menu

2. Press \( \text{\textparagraph} \) to select a tab, then press \( \text{\textparagraph} \).

CAMERA tab

PICTURE tab

CARD tab

SETUP tab

Press \( \text{\textparagraph} \) to return to the tab selection screen.
3 Press to select the item you want to set, then press .

The green frame moves to the selected item.

4 Press to select the option for the selected item. Press to complete your setting.
- Press again to exit the menu and return to shooting.

Note
- Not all items can be selected depending on the status of the camera and the settings performed.
- You can take pictures by pressing the shutter button in the shooting mode with the menu open.
- If you want to save the settings for when the camera is turned off, set ALL RESET to OFF. “ALL RESET – Saving the camera’s settings” (P. 103)
# Shortcut menus (shooting/playback)

## Shooting mode

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>top menu</td>
<td></td>
</tr>
<tr>
<td>CARD SETUP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCENE, or</td>
<td>top menu</td>
<td></td>
</tr>
</tbody>
</table>

## Playback mode

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOVIE PLAY</td>
<td>Plays back movies. You can also make indexes of still-shots from movies.</td>
<td>P. 94</td>
</tr>
<tr>
<td>INFO</td>
<td>Changes the amount of information displayed on the monitor.</td>
<td>P. 111</td>
</tr>
</tbody>
</table>

## Table

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CNL</td>
<td>Selects self-timer shooting or remote control shooting.</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>SET</td>
<td>Sets the date and time.</td>
<td>P. 24</td>
</tr>
<tr>
<td>REC</td>
<td>Sets the record mode.</td>
<td>P. 79</td>
</tr>
<tr>
<td>CARD SETUP</td>
<td>Formats a card.</td>
<td>P. 115</td>
</tr>
</tbody>
</table>
| MONITOR OFF (MONITOR ON) | Selects whether to turn the monitor on or off.  
- MONITOR OFF is displayed when the monitor is on and MONITOR ON is displayed when it is off. | P. 45 |
| MOVIE PLAY | Runs through all saved pictures one after another. | P. 92 |
| INFO | Changes the amount of information displayed on the monitor. | P. 113 |

- MONITOR OFF is displayed when the monitor is on and MONITOR ON is displayed when it is off.
The MODE MENU functions are categorized under tabs. Press ◀️▶️ to select a tab and display the associated menu items.

### CAMERA tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCENE*</td>
<td>Selects a scene shooting mode from ☀️, ☁️, ☁️, and 🌃.</td>
<td>P. 36</td>
</tr>
<tr>
<td>😃/ıp</td>
<td>Selects self-timer shooting or remote control shooting.</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>DRIVE</td>
<td>Selects from 🎧 (single-frame shooting), 🎧 (sequential shooting), AF⃣️ (AF sequential shooting) or BKT (auto bracketing).</td>
<td>P. 68</td>
</tr>
<tr>
<td>ISO</td>
<td>Selects the ISO sensitivity.</td>
<td>P. 83</td>
</tr>
<tr>
<td>🎧</td>
<td>Adjusts the flash intensity.</td>
<td>P. 57</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>Reduces the noise in images that is generated by long exposures when shooting under low-light conditions.</td>
<td>P. 88</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>Digitally increases the optical zoom range to a maximum of approximately 12x.</td>
<td>P. 52</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>Keeps the image in focus at all times without having to press the shutter button halfway.</td>
<td>P. 61</td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>Sets when using an underwater housing.</td>
<td>P. 78</td>
</tr>
<tr>
<td>🎧</td>
<td>Records sound when taking a still picture.</td>
<td>P. 75</td>
</tr>
<tr>
<td>🌃</td>
<td>Allows pictures to be taken as close as 4 cm/1.6&quot; from the subject.</td>
<td>P. 64</td>
</tr>
<tr>
<td>PANORAMA</td>
<td>Allows panorama pictures to be taken with Olympus CAMEDIA-brand cards.</td>
<td>P. 71</td>
</tr>
</tbody>
</table>

* SCENE can be selected when the mode dial is set to SCENE.
### CARD tab

| CARD SETUP | Formats a card. | P. 115 |

### SETUP tab

| ALL RESET | Selects whether to keep the current camera settings when you turn off the power. | P. 103 |
| § | Selects a language for on-screen display. | P. 26 |
| PW ON/OFF SETUP | You can select whether to display the startup/shutdown screen or adjust the sound volume when the power is turned on/off. | P. 120 |
| REC VIEW | Selects whether to display the image being recorded onto the card. | P. 121 |
| | Turns off the beep/warning sound or selects the sound volume. | P. 117 |
| SHUTTER SOUND | Sets the sound generated when the shutter button is pressed and adjusts the volume. | P. 118 |

### 2 IN 1

Combines two still pictures taken in succession and stores them as a single picture. P. 73

### FUNCTION

Lets you add special effects to pictures (BLACK & WHITE, SEPIA). P. 74

### INFO

Selects whether to display all the information such as shutter speed and white balance, or only the minimum information. P. 111

###  PICTURE tab

| | Sets the record mode. | P. 79 |
| WB | Sets the white balance appropriate to the light source. | P. 85 |
| SHARPNESS | Adjusts the sharpness of images. | P. 86 |
| CONTRAST | Adjusts the contrast of images. | P. 87 |

### CARD tab

| CARD SETUP | Formats a card. | P. 115 |

### SETUP tab

| ALL RESET | Selects whether to keep the current camera settings when you turn off the power. | P. 103 |
| § | Selects a language for on-screen display. | P. 26 |
| PW ON/OFF SETUP | You can select whether to display the startup/shutdown screen or adjust the sound volume when the power is turned on/off. | P. 120 |
| REC VIEW | Selects whether to display the image being recorded onto the card. | P. 121 |
| | Turns off the beep/warning sound or selects the sound volume. | P. 117 |
| SHUTTER SOUND | Sets the sound generated when the shutter button is pressed and adjusts the volume. | P. 118 |
### MODE MENU (shooting)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLAY</td>
<td>Rotates recorded pictures 90 degrees clockwise (+90°), or counter-clockwise (−90°) and displays them.</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Stores print reservation data on the card.</td>
<td>127</td>
</tr>
<tr>
<td></td>
<td>Adds sound to a still picture already taken.</td>
<td>98</td>
</tr>
</tbody>
</table>

### MODE MENU (playback)

The menu items available in MODE MENU during still picture playback are different from those available during movie playback. Press " " to select a tab and display the associated menu items.

#### During still picture playback

- **PLAY tab**
  - Rotates recorded pictures 90 degrees clockwise (+90°), or counter-clockwise (−90°) and displays them.  
  - Stores print reservation data on the card. 
  - Adds sound to a still picture already taken.

#### During movie playback

- CARD SETUP

---

**SLEEP**
Sets the time before the sleep mode (idle mode) begins.  
**MY MODE SETUP**
Registers settings you customized.  
**FILE NAME**
Selects how to name files and folders of images to be saved.  
**PIXEL MAPPING**
Checks the CCD and image processing functions for errors.  
**PLAY**
Adjusts the monitor brightness.  
**VIDEO OUT**
Selects NTSC or PAL according to your TV’s video signal type.  
**SHORT CUT**
Lets you register your choice of functions in shortcut menus on the top menu.
## MODE MENU (playback)

### SETUP tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET</td>
<td>Selects whether to keep the current camera settings when you turn off the power.</td>
<td>103</td>
</tr>
<tr>
<td>PW ON/OFF</td>
<td>You can select whether to display the startup/shutdown screen or adjust the sound volume when the power is turned on/off.</td>
<td>120</td>
</tr>
<tr>
<td>CARD SETUP</td>
<td>Erases all image data stored on the card or formats the card.</td>
<td>102, 115</td>
</tr>
<tr>
<td>VOLUME</td>
<td>Adjusts the sound volume during playback.</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Adjusts the monitor brightness.</td>
<td>117</td>
</tr>
<tr>
<td></td>
<td>Sets the date and time.</td>
<td>24</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>Selects NTSC or PAL according to your TV's video signal type.</td>
<td>122</td>
</tr>
<tr>
<td>INDEX DISPLAY</td>
<td>Selects the number of frames in the index display.</td>
<td>91</td>
</tr>
</tbody>
</table>

### CARD tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARD SETUP</td>
<td>Erases all image data stored on the card or formats the card.</td>
<td>102, 115</td>
</tr>
</tbody>
</table>

### EDIT tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Makes the file size smaller and saves it as a new picture.</td>
<td>99</td>
</tr>
</tbody>
</table>
3 Shooting basics

Shooting modes

Set the mode dial (and also set the MODE MENU as needed) to select the appropriate shooting mode depending on the type of shooting conditions.

⚠️ Note

• Rotating the mode dial may return some settings to the factory default settings even when ALL RESET is set to OFF.

**AUTO** Full-auto shooting

Easy to use automatic mode selecting the optimal exposure and focus for general photography. In Full auto, special functions and controls such as Flash intensity control or drive modes cannot be set by the user. This is the simplest of all shooting modes.

**Portrait shooting**

Suitable for shooting a portrait-style image of a person. This mode features an in-focus subject against a blurred background. The camera automatically sets the optimal shooting settings.

**Night-Scene shooting**

Suitable for shooting pictures of outdoor scenes in the evening or at night. For example, if you take a picture of a street at night in other modes, the lack of brightness will result in a dark picture with only the sparkle of lights such as street lamps appearing. In the Night Scene shooting mode, the true appearance of the street can be captured. The camera automatically selects the optimal settings for this type of shooting condition. Since the shutter speed is slow, make sure you stabilize the camera by using a tripod.
**SCENE Scene shooting**

Enables you to select one of the following scene shooting modes available in the menu. "How to use the menus" (P. 28), “MODE MENU (shooting)” (P. 31)

- SCENE can be selected on the MODE MENU only when the mode dial is set to **SCENE**.
- It is useful to assign SCENE to the shortcut menu so you can access quickly. "SHORT CUT" (P. 105)

⚠️ **Landscape+Scene shooting**

Suitable for taking pictures of landscapes and other outdoor scenes. This mode produces clear, sharp pictures with excellent detail, making it ideal for shooting natural scenery.

⚠️ **Landscape+Portrait shooting**

Suitable for taking photos of both your subject and the background. The picture is taken with the background as well as the subject in the foreground in focus. The camera automatically sets the optimal shooting settings.

📸 **Self Portrait shooting**

Enables you to take a picture of yourself while holding the camera. Point the lens towards you and take a shot. The focus is locked on you (shooter). The camera automatically selects the optimal settings for this type of shooting condition. Zooming is not possible in this mode.

❓ **Sports shooting**

Suitable for capturing fast-moving action without blurring. The camera automatically sets the optimal shooting conditions.
**Movie recording**

Allows you to record movies. The camera sets the aperture and shutter speed automatically. See “Movie recording” (P. 49)

**My Mode**

Enables you to make settings manually and register them in the mode dial’s mode so you can call up your own shooting mode whenever you want. Also, if you like the current settings you are using in the P, A, S or M mode, you can shift them to the M mode to register. See “MY MODE SETUP — Registering customized settings in the M mode” (P. 108)

**Program shooting**

Allows you to shoot using an aperture and shutter speed that the camera sets. You can set the flash, white balance, or other functions manually.

**Aperture priority shooting**

Allows you to set the aperture manually. The camera sets the shutter speed automatically. By decreasing the aperture value (F-number), the camera will focus within a smaller range, producing a picture with a blurred background. Increasing the value will let the camera focus over a wider range in the forward and backward directions, resulting in a picture in which both the subject and the background are in focus. See “Aperture priority shooting” (P. 58)

Aperture (F-number) is decreased.  
Aperture (F-number) is increased.
Shooting modes

S  **Shutter priority shooting**

Allows you to set the shutter speed manually. The camera sets the aperture automatically. Set the shutter speed according to the subject and the type of effect you want. “Shutter priority shooting” (P. 59)

![Setting the shutter speed higher lets you capture fast-moving action without blur. The subject will be clear and sharp, as if it is not moving.](image1)

![Setting the shutter speed lower blurs a moving subject, giving the impression of movement.](image2)

M  **Manual shooting**

Allows you to set the aperture and shutter speed manually. To check the exposure, refer to the exposure differential. This mode gives you more creative control, allowing you to make the settings you need to get the type of picture you want, regardless of optimum exposure.

“Manual shooting” (P. 60)
Hold the camera firmly with both hands while keeping your elbows at your sides to prevent camera movement.

- **When using a tripod, attach it after opening the lens barrier. The lens barrier is difficult to open with a tripod attached.**

**Correct**

**Horizontal grip**

**Vertical grip**

- When shooting vertically using the flash, hold the camera so that the flash is higher than the lens.

**Incorrect**

- Keep your fingers and the strap away from the lens and flash.

Note
How to press the shutter button

1. Point the camera towards the subject. Place the AF target mark on the subject. Press the shutter button slowly and gently (halfway).
   - When the focus and exposure (brightness) are locked, the green lamp on the monitor and next to the viewfinder light steadily.

2. Press the shutter button all the way (fully).
   - Shooting starts and the card access lamp blinks.
   - In the mode, the camera starts recording a movie and the orange lamp next to the viewfinder lights.
Taking still pictures

Taking still pictures using the monitor

You can shoot while checking the picture area that the camera actually records. You can also check the shooting status, such as the aperture value and shutter speed.

Using the camera with the monitor on will shorten the life of the battery. You are recommended to turn off the monitor if you do not need it.

1. Open the lens barrier.
   - The power lamp lights and the monitor turns on. If the monitor does not turn on, press to display the top menu and select MONITOR ON. “How to use the menus” (P. 28)

2. Position the AF target mark on the subject while looking at the image on the monitor.

3. Press the shutter button gently (halfway) to adjust the focus.
   - When the focus and exposure are locked, the green lamp on the monitor lights steadily.
   - lights when the flash fires. P. 55

4. Press the shutter button all the way (fully).
   - The bottom of the memory gauge lights, the card access lamp blinks, and the camera begins storing pictures on the card.
Taking still pictures

TIPS

- **The monitor turned off.**
  - If the camera is not used for over 3 minutes, the monitor turns off automatically, and another 15 minutes later, the lens is retracted. Operate the shutter button or zoom lever to turn the monitor on.

- **The monitor is hard to see.**
  - Bright light, such as direct sunlight, may cause vertical lines to appear on the monitor screen. Although this does not affect the actual recorded pictures, use the viewfinder instead if you are having trouble seeing the image.

Taking still pictures using the viewfinder

The camera actually records a wider area than the picture you compose while looking through the viewfinder.

1. **Open the lens barrier.**
   - The power lamp lights.
   - To turn off the monitor, press ☞ to display the top menu and select MONITOR OFF. ☞ “How to turn off the monitor” (P. 45)

2. **Position the AF target mark in the viewfinder on the subject.**

3. **Press the shutter button gently (halfway) to adjust the focus.**
   - When the focus and exposure are locked, the green lamp next to the viewfinder lights steadily.
   - When the orange lamp next to the viewfinder lights steadily, the flash fires. ☞ P. 55

4. **Press the shutter button all the way (fully).**
   - The camera takes the picture.
   - The card access lamp blinks while the picture is stored on the card.
TIPS

• The subject cannot be focused on.
  “If correct focus cannot be obtained” (P. 46)

• The green lamp blinks.
  → You are too close to the subject. Take the picture at least 20 cm (7.9”) away from the subject. If you use the super macro mode, you can take pictures as close as 4 cm (1.6”) from the subject.
  “Super macro shooting” (P. 64)
  → Depending on the subject, the focus may not be locked.
  “If correct focus cannot be obtained” (P. 46)

• The orange lamp blinks slowly when the shutter button is pressed halfway.
  → The flash is charging. Wait until the lamp goes off.

• To check the picture you have just taken immediately.
  → Set REC VIEW to ON. “REC VIEW – Checking the picture immediately after shooting” (P. 121)
  → You can check the picture you have taken by pressing the (playback) button. P. 89

Note

• Press the shutter button gently using the ball of your finger. If the button is pressed hard, the camera may move and pictures may come out blurred.

• Recorded pictures will remain on the card if the camera is turned off or the battery or card is replaced.

• Never open the battery/card compartment cover or disconnect the optional AC adapter while the card access lamp is blinking. Doing so could destroy stored pictures and prevent storage of pictures you have just taken.
Comparison of the monitor & viewfinder

<table>
<thead>
<tr>
<th>Advantage</th>
<th>LCD Monitor</th>
<th>Viewfinder</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can check the picture area that the camera actually records.</td>
<td>Camera movement does not occur easily and subjects can be seen clearly even in bright places. Little battery power is used.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Disadvantage</th>
<th>LCD Monitor</th>
<th>Viewfinder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera movement can occur easily and subjects may be difficult to see in bright/dark places. The monitor uses more battery power than the viewfinder.</td>
<td>When close to a subject, the image in the viewfinder is a little different from the picture that the camera actually records.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tips</th>
<th>LCD Monitor</th>
<th>Viewfinder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the monitor when you want to shoot while checking the picture area that the camera actually records. Use also for close-up shots of people or flowers, or for macro shooting.</td>
<td>Use the viewfinder for general snapshots (landscape pictures, casual shots, etc.).</td>
<td></td>
</tr>
</tbody>
</table>

- The camera records a wider area than the image in the viewfinder.
- As you get closer to the subject, the actual image recorded (striped area) becomes lower than the one in the viewfinder (see left).
How to turn off the monitor

You can set the monitor to turn on or off when the camera is powered on in the shooting mode.

1 Press \( \text{\textbullet} \) .
   - The top menu is displayed.

2 Press \( \text{\textbullet} \) .

3 The monitor turns off (MONITOR OFF).
   - To turn the monitor back on, press \( \text{\textbullet} \) to display the top menu and press \( \text{\textbullet} \) to select MONITOR ON. MONITOR ON is displayed on the top menu when the monitor is set to off.
If correct focus cannot be obtained

When the subject you want to focus on is not in the center of the frame and you cannot position the AF target mark on it, you can focus the camera on another point at roughly the same distance (focus lock) and take the picture as explained below.

Determine the position of the subject after focusing (Focus Lock)

Available modes

1 Position the AF target mark on the subject you want to focus on.
   ● When shooting a hard-to-focus subject or a fast-moving subject, point the camera at an object about the same distance away as the subject.

2 Press the shutter button halfway and make sure the green lamp lights steadily.
   ● When the focus and exposure are locked, the green lamp lights steadily.
   ● If the green lamp blinks, the focus and exposure are not locked. Release your finger from the shutter button, re-position the AF target mark on the subject and press the shutter button halfway again.
3 Keeping the shutter button pressed halfway, recompose your shot.

4 Press the shutter button all the way (fully).
If correct focus cannot be obtained

When Auto focus does not work (Subjects that are difficult to focus on)

Under the following conditions auto focus may not work properly. If this happens, focus on an object with high contrast at the same distance as the intended subject (P. 46, “Focus Lock”), recompose your shot and then take the picture. If the subject has no vertical lines, hold the camera vertically and lock the focus, then return the camera to the horizontal position to take the picture.

The green lamp blinks: The subject cannot be brought into focus.

- Subjects with low contrast
- Subjects with no vertical lines
- Subjects in excessively bright light in the center of the frame

The green lamp lights, but the subject cannot be brought into focus:

- Subjects at different distances
- Fast-moving subjects
- The subject to be focused on is not in the center of the frame.
Movie recording

Sound is recorded at the same time. The focus and zoom are locked. If the distance to the subject changes, focus may be compromised. The optical zoom is not available.

Available modes

1 Set the mode dial to 🎥 .
   - The remaining recording time is displayed on the monitor.

2 Decide the composition while looking at the image on the monitor.

3 Press the shutter button fully to start recording.
   - The focus and zoom are locked.
   - The orange lamp next to the viewfinder lights.
   - During movie recording, 📼 lights red.

4 Press the shutter button again to stop recording.
   - When the remaining recording time has been used up, recording stops automatically.

TIPS

• To record movies without sound.
  → In the top menu, select 🎧 → OFF.
  📧 “Recording sound with movies” (P. 77)

• To use the zoom while shooting.
  → Set DIGITAL ZOOM to ON.
  📧 “Using the digital zoom” (P. 52)
Shooting basics

Movie recording

• The flash cannot be used.
• It takes longer to store movies than still pictures.
• The remaining recording time depends on the selected record mode, free space available on the card, etc.

Note

• Recording will continue until the card is full unless stopped by pressing the shutter button.
• If a single movie recording uses up all of the card’s memory, create space on the card by deleting the movie or downloading it to a PC.

Notes for recording movies over a long time
Telephoto and wide-angle shooting are possible at 3x magnification (the optical zoom limit, equivalent to 38 mm to 114 mm on a 35 mm camera). By combining the optical zoom with the digital zoom, zoom magnification can be increased to a maximum of approximately 12x. Camera movement is likely to occur at higher magnifications. Stabilize the camera with a tripod, etc. to avoid camera movement. The optical zoom is not available in the \( \mathcal{A} \) mode.

**Using the optical zoom**

1. Operate the zoom lever.

   **Wide-angle:** Push the zoom lever toward \( W \) to zoom out.

   **Telephoto:** Push the zoom lever toward \( T \) to zoom in.
DIGITAL ZOOM — Using the digital zoom

1 In the top menu, select MODE MENU → CAMER A → DIGITAL ZOOM → ON, and press • “How to use the menus” (P. 28)
• Press again to exit the menu and the subject is displayed on the monitor.

2 Push the zoom lever toward T.
• The white area of the zoom indicator shows the optical zoom. If the digital zoom is set to ON, a red area appears on the zoom indicator. When you reach the limit of the optical zoom, the digital zoom is enabled.

Note
• In the mode, the maximum digital zoom magnification is 3.0x.
• Pictures taken with the digital zoom may appear grainy.
• The digital zoom cannot be used when the monitor is turned off. Turn the monitor on to enable the digital zoom.
Flash shooting

You can select a flash mode appropriate to the light conditions and the effect you want to achieve. You can also adjust the amount of light emitted using the flash intensity control. P. 57

The flash modes are as follows:

**Auto-flash (No indication)**

Automatically fires in low-light and backlight conditions.

**Red-eye reduction flash**

The light from the flash may make the subject’s eyes appear red in the picture. The red-eye reduction flash mode significantly reduces this phenomenon by emitting pre-flashes before firing the regular flash. This helps accustom the subject’s eyes to the bright light and minimizes the red-eye phenomenon.

- After the pre-flash, it takes approximately 1 second before the shutter is released. Hold the camera firmly after the pre-flash to prevent camera movement.
- Effectiveness may be limited if the subject is not looking directly at the pre-flashes, or if the shooting range is too far. Individual physical characteristics, such as light-colored eyes, may also limit effectiveness.

**Fill-in flash**

The flash fires regardless of available light. This mode is useful for eliminating shadows on the subject’s face or for correcting the color shift produced by artificial lighting (especially fluorescent light).

- Fill-in flash may not have the desired effect under excessively bright light.
Flash shooting

**Flash off**

The flash does not fire even in low light conditions. Use this mode in situations where flash photography is not desired or is prohibited. You can also use this mode when you want to shoot a natural-looking twilight or night scene.

- Since a slow shutter speed is automatically selected in low-light situations when in the flash off mode, the use of a tripod is recommended to prevent your pictures from being blurred by camera movement.

**Slow synchronization** 

The slow synchronization flash is designed for slow shutter speeds. Normally, when shooting with a flash, shutter speeds cannot go below a certain level to prevent camera movement. But when shooting a night scene background, fast shutter speeds can make the background too dark. Slow synchronization flash allows both a slow shutter speed for the background and a flash for the subject. Since the shutter speed is slow, make sure you stabilize the camera by using a tripod. Otherwise, camera movement may cause the image to be blurred.

In **S** and **M** modes, the flash fires at the selected shutter speed.

- **Slow synchronization:** SLOW
- **Slow synchronization with red-eye reduction:** SLOW

This is for when you want to use slow synchronization yet also reduce red-eye. For instance, when shooting a person against a brightly lit night background. A normal flash might make the person’s eyes red, but slow synchronization with red-eye reduction lets you capture the background correctly and reduce red-eye at the same time.
Using the flash

1 Press the \( \mathbf{\Phi} \) (flash mode) button repeatedly until the desired flash mode indication appears.

![Mode indication diagram]

- If \( \mathbf{\Phi} \) is not pressed for 2 seconds, the selection screen disappears.

2 Take the picture.
- The orange lamp and the \( \mathbf{\Phi} \) (flash standby) mark light when the flash is ready to fire.

Flash working range
W (max.): Approx. 0.2 m to 3.4 m (0.6 ft to 11.2 ft)
T (max.) : Approx. 0.3 m to 2.0 m (1.0 ft to 6.6 ft)
Flash shooting

### Flash modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>AUTO</th>
<th></th>
<th></th>
<th></th>
<th>P</th>
<th>A</th>
<th>S</th>
<th>M *</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-flash</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

/: Available, – : Not available, : Factory default setting

* Available flash modes and the factory default settings depend on the shooting mode (P, A, S or M) registered in the mode.

---

### TIPS

- **The orange lamp or the (flash standby) mark blinks.**
  - The flash is charging. Wait until the orange lamp or lights steadily.

- **Camera movement warning (auto, red-eye reduction , fill-in ).**
  - When the orange lamp or (camera movement warning) lights up, the shutter speed locks at its current level. This helps prevent camera movement problems (shutter speeds that are too slow can cause blur). However, if the zoom magnification is increased, the camera will increase the locked shutter speed accordingly.

**Zoom position & shutter speed**

W (max.): 1/30 sec., T (max.): 1/100 sec.

---

### Note

- **The flash does not fire in the following situations:**
  - In the mode, during auto bracketing (BKT), during super-macro shooting, during panorama shooting.
  - The flash may not give you the optimum result in macro mode, especially with wide-angle shooting. Check the resulting picture on the monitor.
Flash intensity control

You can adjust the amount of light emitted by the flash. In some situations, you may get better results by adjusting light emission. Examples include small subjects, distant backgrounds, or situations when increased contrast is desired. This function is also useful for adjusting the contrast of images.

1. In the top menu, select MODE MENU → CAMERA →  
   “How to use the menus” (P. 28)

2. Press to adjust, then press .
   • Press again to exit the menu.

Adjustable range

Less bright  
-2EV  -1EV  
Normal flash intensity  
±0  +1EV  +2EV  
More bright  
+1/3EV

: Light emission is increased by a 1/3 EV each time you press the button.
: Light emission is decreased by a 1/3 EV each time you press the button.
(EV: Exposure Value)

Factory default setting: ±0

• The flash adjustment effect may not be sufficient if the shutter speed is too fast.

Note
4 Advanced shooting

Aperture priority shooting

**1.** Set the mode dial to **A**.

**2.** Set the aperture value.

   To increase the aperture value (F-number), press \[\text{ }\].

   To decrease the aperture value (F-number), press \[\text{ }\].

**3.** Take the picture.

- **The aperture value is displayed in green**
  The aperture you have set will provide optimum exposure.

- **The aperture value is displayed in red**
  The aperture you have set is unsuitable for the conditions.
  \(\downarrow\) appears: Press \[\text{ }\] to decrease the aperture value.
  \(\uparrow\) appears: Press \[\text{ }\] to increase the aperture value.

**Available modes**

<table>
<thead>
<tr>
<th>Zoom position</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wide (W)</td>
<td>f2.8* to f8.0</td>
</tr>
<tr>
<td>Tele (T)</td>
<td>f4.8* to f8.0</td>
</tr>
</tbody>
</table>

* Open-aperture (the widest aperture setting) depends on the zoom position.

**Note**

- When the flash is set to the auto-flash mode, the shutter speed is fixed at 1/30 second in the maximum wide-angle, or 1/100 second in the maximum telephoto, and can never go slower.
Shutter priority shooting

1 Set the mode dial to S.

2 Set the shutter speed.
   To set a faster shutter speed, press $\downarrow$.
   To set a slower shutter speed, press $\uparrow$.

3 Take the picture.

- **The shutter speed is displayed in green**
  The shutter speed you have set will provide optimum exposure.

- **The shutter speed is displayed in red**
  The shutter speed you have set is unsuitable for the conditions.
  $\downarrow$ appears: Press $\downarrow$ to set the shutter speed slower.
  $\uparrow$ appears: Press $\uparrow$ to set the shutter speed faster.

**Shutter speed range:** 4 to 1/1000 sec.
1 Set the mode dial to M.

2 Set the aperture value and shutter speed.

   To set a faster shutter speed, press ↓.

   To increase the aperture value (F-number), press ．

   To decrease the aperture value (F-number), press ．

   To set a slower shutter speed, press ↓．

3 Take the picture.

F-number:  
W → f2.8 * to f8.0
T → f4.8 * to f8.0
Shutter speed: 8 to 1/1000 sec.

■ Exposure differential

• The difference (ranging from –3.0 to +3.0) between the exposure determined by the currently selected aperture and shutter speed and the exposure considered optimal by the camera appears in the upper right-hand corner.

• When the exposure differential is set to less than –3.0 or more than +3.0, the exposure differential appears in red.

Note

• To avoid camera movement, we recommend use of a tripod for any effect which uses a slow shutter speed.
FULLTIME AF — A reliable time-saving way to focus

Focusing is performed repeatedly without having to press the shutter button halfway. The focusing time is reduced, letting you take successive snapshots.

**Available modes**

1. In the top menu, select MODE MENU → CAMERA → FULLTIME AF → ON, and press .
   - “How to use the menus” (P. 28)
   - If the monitor is turned off, FULLTIME AF does not function.
   - Press again to exit the menu.

- Battery consumption increases when FULLTIME AF is used.

**Note**
Selecting the metering area

There are 2 ways of measuring the brightness of a subject: Center-weighted metering and spot metering.

**Center-weighted metering**
Meters the brightness over a wide area with emphasis on the center of the screen. This method is used when you do not want to let the brightness of the surrounding area affect the picture.

**Spot metering**
Meters within the AF target mark to determine exposure. A subject can be shot with optimal exposure regardless of the background light (such as when the subject is dark due to back lighting.) When  is set, you can use spot metering when shooting up close to a subject.

1. Press the  (macro/spot) button repeatedly until  (spot metering) or  (spot metering+ macro mode) appears.

   ![Mode indication diagram]

   - If  is not pressed for 2 seconds, the selection screen disappears.

2. Take the picture.

   **Factory default setting:**  OFF (Center-weighted metering)
Macro mode shooting — Taking close-up pictures

Macro shooting allows you to shoot from as close as 30 cm (1.0 ft) to a subject while the zoom lever is pressed to the maximum T position. You can fill the entire frame with a very small subject. As the center of the frame (within the AF target mark) is metered and optimal exposure is obtained when is set, the picture turns out well. “Selecting the metering area” (P. 62)

1 Press the (macro/spot) button repeatedly until (macro mode) or (spot metering+ macro mode) appears.

   - If is not pressed for 2 seconds, the selection screen disappears.

2 Take the picture while observing your subject on the monitor.

   Macro shooting range
   Wide (W) : 20 cm to 50 cm (0.7 ft to 1.6 ft)
   Tele (T) : 30 cm to 50 cm (1.0 ft to 1.6 ft)

   Factory default setting: OFF (Center-weighted metering)

   • If is not pressed for 2 seconds, the selection screen disappears.

Note
   • If you use the flash in macro shooting, shadows may be noticeable and the correct exposure may not be achieved.
Super macro shooting

This mode lets you shoot a small subject that macro shooting cannot capture. You can shoot from as close as 4 cm (1.6") to a subject with the zoom lever pressed to the maximum W position.

Available modes

1. In the top menu, select MODE MENU → CAMERA → → ON, and press .

   “How to use the menus” (P. 28)
   - Press again to exit the menu.

2. Take a picture while observing your subject on the monitor.

   • In the mode, the flash is set to the off mode .
   • When taking pictures close to the subject, shadows may become noticeable, and the auto focus may not be able to maintain correct focus.
Self-timer shooting

This function is useful for taking pictures where you want to be included in the photograph.

Available modes

1. In the top menu, select MODE MENU → CAMERA → Self-timer/Remote control lamp. Press .

   - “How to use the menus” (P. 28)
   - Press again to exit the menu.
   - If Self-timer/Remote control lamp is displayed on the top menu as a shortcut menu, press the arrow pad in the same direction as the arrow shown next to Self-timer/Remote control lamp. “SHORT CUT” (P. 105)

2. Take the picture.
   - The self-timer starts.
   - The self-timer/remote control lamp lights up for approximately 10 seconds, then starts blinking. After blinking for approximately 2 seconds, the picture is taken.
   - Movie recording starts approximately 12 seconds after pressing the shutter button. To stop recording, press the shutter button fully again.
   - To stop the self-timer, press . The self-timer/remote control lamp will turn off.

Note

- The self-timer is canceled automatically when shooting is finished.
- In the Self-timer/Remote control lamp mode, the camera automatically stops recording when the remaining recording time has been used up.
Remote control shooting

Shooting is possible using the remote control. This is useful when you want to take a picture with yourself in it, or a night scene, without touching the camera.

1 In the top menu, select MODE MENU → CAMERA → On/Off → [ . Press . [“How to use the menus” (P. 28)
   • Press again to exit the menu.
   • If On/Off is displayed on the top menu as a shortcut menu, press the arrow pad in the same direction as the arrow shown next to On/Off. [“SHORT CUT” (P. 105)

2 Point the remote control at the remote control receiver on the camera. Press the shutter button on the remote control.
   • The camera’s self-timer/remote control lamp blinks for about 2 seconds before taking the picture.
   • The remote control mode is not canceled automatically after shooting. Perform step 1: Set On/Off to OFF.

Transmitted remote control signal effective area

Self-timer/Remote control lamp
Remote control receiver
Shutter button
Remote control shooting

Advanced shooting

TIPS

• If the camera’s self-timer/remote control lamp does not blink after pressing the shutter button on the remote control.
  → The remote control may be too far away from the camera. Move the remote control or change your position as necessary so that the remote control signal can reach the camera, then press the shutter button again on the remote control.
  → The battery in the remote control device is running low. Replace with a new battery. How to replace the battery (CR2025) of the remote control device” (P. 162)

Note

• If the remote control receiver is exposed to strong light, such as direct sunlight, shooting may not take place, even if the remote control is within the effective signal distance.
• To shoot sequential shots using the remote control, press and hold the shutter button on the remote control. If the camera does not receive the remote control signal properly, sequential shooting may stop.
Sequential shooting

There are 3 sequential shooting modes: sequential shooting ( ), AF sequential shooting ( ) and auto bracketing (BKT).

Drive mode

: Shoots 1 frame.

: Shoots a maximum number of 3 frames (in the HQ mode) sequentially at approximately 1 frame/sec. Focus, exposure and white balance are locked at the first frame.

: Shoots pictures sequentially. Adjusts the focus 1 frame at a time. The AF sequential shooting speed is lower than normal sequential shooting.

BKT : Auto bracketing. P. 69

Sequential shooting & AF sequential shooting

1 In the top menu, select MODE MENU → CAMERA → DRIVE → or .

Press .

“How to use the menus” (P. 28)

Press again to exit the menu.

2 Take pictures.

Press the shutter button all the way and keep it pressed. The camera will take pictures in sequence until you release the button.
Auto bracketing — Shooting pictures sequentially with a different exposure for each frame

Under some conditions, you may obtain better results shooting with exposure compensation than by using the exposure setting considered optimal by the camera.

During auto bracketing, exposure is changed for each frame. The exposure differential and number of frames can be selected in the menus. The focus and white balance are locked at the first frame.

**Example:** When BKT is set to ±1.0, x3

![Example images](image1)

Available modes:

1. In the top menu, select MODE MENU → CAMERA → DRIVE → BKT. Press .
   "How to use the menus" (P. 28)

2. Press to select the exposure differential between each frame (±0.3, ±0.7, ±1.0), then press .

![Menu selection](image2)
3 Press ◀◀ to select the number of frames to shoot (x3 or x5), then press ◐.
   - In some combinations of picture size and record mode, only x3 is available.
   - Press ◐ twice to exit the menu.

4 Take pictures.
   - Press the shutter button all the way and keep it pressed to shoot the preset number of pictures. You can stop shooting at any time by releasing the shutter button.

Note

- If sequential shooting (◢ ◣, ◢◤) is attempted when the flash mode is set to red-eye reduction ◤, the flash mode will change to autoflash. If sequential shooting (◢ ◣, ◢◤) is attempted when the flash mode is set to slow synchronization with red-eye reduction, the flash mode will change to slow synchronization.
- During auto bracketing (BKT), the flash is set to the off mode ◢.
- Sequential shooting (◢ ◣, ◢◤, BKT) is not available when the record mode is set to TIFF.
- If there is not enough space available on the card for the number of frames you have set during auto bracketing, you cannot continue shooting.
- If the battery power dies during sequential shooting, shooting stops and the camera starts saving the pictures you have taken. Whether or not all of the shots are saved depends on how much battery power remains.
- It takes longer than usual to store pictures after sequential shooting.
Panorama shooting

You can take advantage of panorama shooting with an Olympus xD-Picture Card. Panorama shooting lets you connect images with overlapping edges into a single panoramic image, using CAMEDIA Master software (contained on the provided CD-ROM).

Available modes:

1. **In the top menu, select MODE MENU → CAMERA → PANORAMA. Press .**
   
   “How to use the menus” (P. 28)

2. **On the monitor, use the arrow pad to choose the direction you want the pictures connected.**
   - : Connects the pictures from left to right.
   - : Connects the pictures from right to left.
   - : Connects the pictures from bottom to top.
   - : Connects the pictures from top to bottom.

3. **Make sure that the edges of images overlap, then take your pictures.**
   - Focus, exposure and white balance are set by the first picture. Do not select an extremely bright subject (such as the sun) for the first picture.
   - You cannot adjust the zoom after the first picture.
   - Panorama shooting is possible for up to 10 pictures.
Panorama shooting

4 Press  to finish panorama shooting.
   • Frames on the edges of the screen disappear, and the camera returns to the normal shooting mode.

Note

• If  is set to A, S or M, panorama shooting is not available.
• During panorama shooting, the flash and sequential shooting are not available.
• If you take 10 pictures, a warning screen appears and no more pictures can be taken.

• Panorama shooting is only available using cards with panorama function.
• The camera itself cannot connect panorama pictures. To connect each picture, use the CAMEDIA Master software.
• If panorama shooting is done in the TIFF record mode, images are saved with the same resolution in the JPEG format.
• If the mode dial is moved during panorama shooting, the camera cancels panorama shooting and returns to normal shooting.
Taking two-in-one pictures

Allows you to combine two pictures taken in succession and store them as a single picture.

1 In the top menu, select MODE MENU → CAMERA → 2 IN 1. Press .
   - “How to use the menus” (P. 28)
   - The 2 IN 1 picture mode is set. The monitor turns on automatically.

2 Take the first shot.
   - The subject will be on the left in the combined image.
   - To cancel the two-in-one picture mode after taking the first shot, press . The first shot will not be stored.

3 Take the second shot in succession.
   - The subject will be on the right in the combined image.
Advanced shooting

Taking two-in-one pictures

In the top menu, select MODE MENU → CAMERA → FUNCTION → BLACK & WHITE or SEPIA and press .

“How to use the menus” (P. 28)

Press again to exit the menu.

This setting lets you add special effects to pictures.

**BLACK & WHITE** : Takes pictures in black and white.

**SEPIA** : Gives pictures a sepia tone.

Note

* During two-in-one (2 IN 1) shooting, the following functions are not available: Panorama shooting, Sequential shooting , AF sequential shooting , Auto bracketing (BKT), recording sound with pictures , histogram display.

* When taking two-in-one (2 IN 1) pictures in the TIFF record mode, the pictures are saved with the same resolution in the JPEG format.

* If the camera enters the sleep mode after the first picture has been taken, the 2 IN 1 picture mode will be canceled. The first picture you took is not saved.

Note

* WB cannot be used in FUNCTION shooting.
Recording sound with still pictures

This function lets you record sound when taking a still picture. Recording starts about 0.5 seconds after the shutter is released and lasts about 4 seconds. When \( \text{ON} \) is set to ON, sound is recorded automatically every time you take a picture.

1. In the top menu, select MODE MENU → CAMERICA → \( \text{ON} \), and press \( \text{ } \).  
   • “How to use the menus” (P. 28)  
   • Press \( \text{ } \) again to exit the menu.

2. When recording starts, turn the camera microphone towards the source of the sound you want to record.  
   • The BUSY bar is displayed during recording.

TIPS

• \( \text{ } \) appears on all still pictures and movies that have recorded sound. During playback, sound is output from the speaker. The volume can be adjusted.  
   • “VOLUME – Adjusting the playback volume” (P. 119)

• Sound can be added later to still pictures. Recorded sound can also be changed.  
   • “Recording sound” (P. 98)
• If the camera is more than 1 m (3.3 ft.) away from the source of the sound, sound may not be recorded clearly.
• It is not possible to take another picture during sound recording.
• Sound recording is not possible in the following cases: When the record mode is set to TIFF, during sequential shooting ( , , BKT), Panorama shooting, two-in-one picture shooting
• Sound recording may also pick up camera noises, such as button operations, shutter movement, etc.
• If memory space is insufficient on the card, recording sound may not be possible.
Recording sound with movies

Sound can be recorded while shooting a movie.

*Available modes*  

1. **In the top menu, select 🎤 → ON, and press 🎫.**
   - "How to use the menus" (P. 28)
   - Press 🎫 again to exit the menu.

2. **Recording starts at the same time as shooting.**

*Note*

- Zoom cannot be used during movie recording. If 🎤 is set to OFF, you can use the digital zoom during movie recording.
- If the camera is more than 1 m (3.3 ft.) away from the source of the sound, sound may not be recorded clearly.
The appropriate setting must be made in the MODE MENU when an optional underwater housing is attached to the camera.

Available modes

1. In the top menu, select MODE MENU → CAMERA → ACCESSORY → (underwater housing), and press .

How to use the menus (P. 28)

- Press again to exit the menu.

Note

- Focusing may take some time when the underwater housing is attached to the camera.
- In the mode, FULLTIME AF is canceled.
You can select a record mode in which to take pictures or shoot movies. Choose the best record mode for your purpose (printing, editing on a PC, website editing, etc.). For information on the image size for each record mode and the number of remaining pictures and remaining recording time for the card, see the table on page 80.

<table>
<thead>
<tr>
<th>Application</th>
<th>Quality (compression)</th>
<th>Uncompressed</th>
<th>Low compression</th>
<th>High compression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select for the print size</td>
<td>Resolution</td>
<td>TIFF</td>
<td>SHQ</td>
<td>HQ</td>
</tr>
<tr>
<td>2816 x 2112</td>
<td>2560 x 1920</td>
<td>SQ1</td>
<td>HIGH</td>
<td>SQ1</td>
</tr>
<tr>
<td>2272 x 1704</td>
<td>2048 x 1536</td>
<td>SQ1</td>
<td>HIGH</td>
<td>SQ1</td>
</tr>
<tr>
<td>1600 x 1200</td>
<td>1280 x 960</td>
<td>SQ2</td>
<td>HIGH</td>
<td>SQ2</td>
</tr>
<tr>
<td>1024 x 768</td>
<td>For small sized print and website</td>
<td>640 x 480</td>
<td>SHQ</td>
<td>HQ</td>
</tr>
</tbody>
</table>

**Resolution**

The number of pixels (horizontal x vertical) used when saving an image. If the image will be printed, higher resolutions (larger numbers) are recommended so that the image will be clearer. However, higher resolutions make the file size (amount of data) larger, so the number of pictures that can be saved will be fewer.

**Compression**

In record modes other than TIFF, image data are compressed. The higher the compression, the less clear the image will be.

**Resolution and picture size on a computer screen**

When a picture is transferred to a computer, the size of the picture on the computer screen varies depending on the computer’s monitor setting. For instance, a picture taken in 1024 x 768 resolution is the same size as the screen if you set the picture to 1x when the monitor setting is 1024 x 768. However, if the monitor setting is over 1024 x 768 (such as 1280 x 1024), the picture only takes up part of the screen.
● Record mode and the number of storable pictures

The approximate number of pictures that can be stored is determined by dividing the memory capacity of the card by the file size of the pictures. When a card is inserted into the camera, the number of storable pictures is displayed on the monitor.

### Still Picture Record Modes

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Resolution</th>
<th>Compression</th>
<th>File format</th>
<th>Number of storable pictures</th>
<th>File size (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF</td>
<td>2816 x 2112</td>
<td>Uncompressed</td>
<td>TIFF</td>
<td>1</td>
<td>Approx. 17.9</td>
</tr>
<tr>
<td></td>
<td>2560 x 1920</td>
<td></td>
<td></td>
<td>2</td>
<td>Approx. 14.8</td>
</tr>
<tr>
<td></td>
<td>2272 x 1704</td>
<td></td>
<td></td>
<td>2</td>
<td>Approx. 11.6</td>
</tr>
<tr>
<td></td>
<td>2048 x 1536</td>
<td></td>
<td></td>
<td>3</td>
<td>Approx. 9.5</td>
</tr>
<tr>
<td></td>
<td>1600 x 1200</td>
<td></td>
<td></td>
<td>5</td>
<td>Approx. 5.8</td>
</tr>
<tr>
<td></td>
<td>1280 x 960</td>
<td></td>
<td></td>
<td>8</td>
<td>Approx. 3.7</td>
</tr>
<tr>
<td></td>
<td>1024 x 768</td>
<td></td>
<td></td>
<td>13</td>
<td>Approx. 2.4</td>
</tr>
<tr>
<td></td>
<td>640 x 480</td>
<td></td>
<td></td>
<td>34</td>
<td>Approx. 0.9</td>
</tr>
<tr>
<td>SHQ</td>
<td>2816 x 2112</td>
<td>Low comp.</td>
<td>JPEG</td>
<td>7</td>
<td>Approx. 4.4</td>
</tr>
<tr>
<td>HQ</td>
<td>2816 x 2112</td>
<td>High comp.</td>
<td>JPEG</td>
<td>21</td>
<td>Approx. 1.5</td>
</tr>
<tr>
<td>SQ1</td>
<td>2560 x 1920</td>
<td>HIGH</td>
<td>JPEG</td>
<td>8</td>
<td>Approx. 3.7</td>
</tr>
<tr>
<td></td>
<td>2272 x 1704</td>
<td>NORMAL</td>
<td>JPEG</td>
<td>25</td>
<td>Approx. 1.2</td>
</tr>
<tr>
<td></td>
<td>2048 x 1536</td>
<td>HIGH</td>
<td>JPEG</td>
<td>11</td>
<td>Approx. 2.9</td>
</tr>
<tr>
<td></td>
<td>1600 x 1200</td>
<td>NORMAL</td>
<td>JPEG</td>
<td>32</td>
<td>Approx. 1.0</td>
</tr>
<tr>
<td></td>
<td>1280 x 960</td>
<td>HIGH</td>
<td>JPEG</td>
<td>13</td>
<td>Approx. 2.3</td>
</tr>
<tr>
<td></td>
<td>1024 x 768</td>
<td>NORMAL</td>
<td>JPEG</td>
<td>39</td>
<td>Approx. 0.8</td>
</tr>
<tr>
<td></td>
<td>640 x 480</td>
<td>HIGH</td>
<td>JPEG</td>
<td>22</td>
<td>Approx. 1.4</td>
</tr>
<tr>
<td>SQ2</td>
<td>1280 x 960</td>
<td>NORMAL</td>
<td>JPEG</td>
<td>62</td>
<td>Approx. 0.5</td>
</tr>
<tr>
<td></td>
<td>1024 x 768</td>
<td>NORMAL</td>
<td>JPEG</td>
<td>34</td>
<td>Approx. 0.9</td>
</tr>
<tr>
<td></td>
<td>640 x 480</td>
<td>NORMAL</td>
<td>JPEG</td>
<td>94</td>
<td>Approx. 0.3</td>
</tr>
</tbody>
</table>

* HIGH uses low compression/NORMAL uses high compression
Movie record modes
Movie data is stored until the card is full.
• Remaining recording time on the card that you are using is displayed in the movie (📸) mode.

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>HQ</td>
<td>320 x240 (15 frames/sec.)</td>
</tr>
<tr>
<td>SQ</td>
<td>160 x120 (15 frames/sec.)</td>
</tr>
</tbody>
</table>

Note
• Number of remaining pictures listed in the table is approximate.
• The number of remaining pictures may change according to the subject or factors like whether print reservations have been made or not. In certain instances, the number of remaining pictures displayed on the monitor does not change even when you take pictures or stored images are erased.

Selecting still picture record modes

1. In the top menu, select MODE MENU ➔ PICTURE ➔ 📸 ➔ TIFF, SHQ, HQ, SQ1 or SQ2. Press 📸. “How to use the menus” (P. 28)
   • To select a resolution for TIFF, SQ1 or SQ2, set the mode dial to any of the positions except AUTO.
   • 📸 is displayed on the top menu as a shortcut menu, press the arrow pad in the same direction as the arrow shown next to 📸. “SHORT CUT” (P. 105)

When you selected SHQ or HQ
Go to step 3.
2 When you selected TIFF in step 1
Press to select a resolution.

When you selected SQ1 or SQ2 in step 1
① Press to select a resolution. Press .
② Press to select HIGH or NORMAL.

3 Press to save the setting.
- Press again to exit the menu.

Selecting movie record modes

1 In the top menu, select MODE MENU → PICTURE → HQ or SQ. Press .
- “How to use the menus” (P. 28)
- Press again to exit the menu.
ISO sensitivity

The higher the ISO value, the greater the camera’s light sensitivity and the better its ability to shoot in low light conditions. However, higher values also introduce noise into the resulting image, which may give them a grainy appearance.

**AUTO**: Sensitivity is automatically adjusted according to the light conditions and the subject brightness.

**64/100/200/400**: With a lower ISO setting, you can shoot clear, sharp images in daylight. With a higher ISO setting, you can shoot in dark places.

---

1. In the top menu, select **MODE MENU → CAMERA → ISO**, then press ‣ to choose the most suitable ISO sensitivity and press ‣.

   - Press ‣ again to exit the menu.

---

<table>
<thead>
<tr>
<th>Modes</th>
<th>AUTO</th>
<th>64</th>
<th>100</th>
<th>200</th>
<th>400</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUTO</td>
<td>🔥</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>64</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>100</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>200</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>400</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

*: Available, —: Not available, ⬅️: Factory default setting

* Available ISO sensitivities and the factory default settings depend on the shooting mode (P, A, S or M) registered in the mode.

---

- Higher ISO settings produce more electrical noise.
- When ISO is set to AUTO and you are shooting in dark conditions without a flash, the sensitivity automatically increases, otherwise the shutter speed will be reduced, possibly resulting in camera movement and blurred images.
- If the subject is too far away for the flash illumination to reach when ISO is set to AUTO, the sensitivity is automatically increased.
- When using slow synchronization in the P, A or S mode, the slowest available shutter speed varies depending on the ISO setting.
Exposure

In some situations, you may get better results when the exposure that the camera sets is compensated (adjusted) manually. You can adjust the exposure by selecting the exposure compensation value. After adjusting the exposure, you can check the picture on the monitor.

Available modes

1. Press to compensate the exposure.

TIPS
- Often bright subjects (such as snow) will turn out darker than their natural colors. Adjusting toward + makes these subjects closer to their real shades. For the same reason, adjust toward – when shooting dark subjects.

Note
- If the flash is used, the image brightness (exposure) may differ from the intended brightness.
- Exposure compensation cannot correct the image if the surroundings of the subject are extremely bright or dark.
White balance

Color reproduction differs depending on the light conditions. For instance, when daylight, the setting sun or tungsten lighting are reflected on white paper, the shade of white produced will be slightly different for each. By setting the WB (white balance), you can achieve more natural-looking colors.

1 In the top menu, select MODE MENU → PICTURE → WB. Press .

2 Press to select the best WB for your shooting conditions. Press .

* “How to use the menu” (P. 28)
  * Press again to exit the menu.

Available modes

AUTO : The white balance is adjusted automatically so that colors look natural irrespective of the light source.

(Sunlight) : For natural colors under a clear sky.

(Overcast) : For natural colors under a cloudy sky.

(Tungsten) : For natural colors under tungsten lighting.

(Fluorescent) : For natural colors under fluorescent lighting.
Adjusting the image quality and exposure

**SHARPNESS**

This function adjusts the sharpness of the image.

1. In the top menu, select MODE MENU → PICTURE → SHARPNESS, and press .

2. Press to adjust the sharpness between +2 and –2.
   - **To increase the sharpness (+)**: The image contours are emphasized, making the image appear sharper and more vivid. Use this setting when you want to print pictures.
   - **To reduce the sharpness (–)**: The image contours are softened. Use this setting when you want to edit images on a PC.
   - When you have finished setting the sharpness, press . Press again to exit the menu.

Note

- Set white balance to AUTO for normal shooting.
- White balance may not be effective under certain light sources.
- After setting a white balance other than AUTO, play back the picture and check the colors on the monitor.
- When the flash is fired with a white balance setting other than AUTO, colors may appear different in the resulting picture from the colors you see on the monitor.

Note

- If you adjust the sharpness too far towards +, noise may become noticeable in the picture.

Note

- Set white balance to AUTO for normal shooting.
- White balance may not be effective under certain light sources.
- After setting a white balance other than AUTO, play back the picture and check the colors on the monitor.
- When the flash is fired with a white balance setting other than AUTO, colors may appear different in the resulting picture from the colors you see on the monitor.
This function adjusts the contrast of the image. For example, you can make images with marked differences in light and shadow softer, and those with less differences more vivid.

Available modes

1 In the top menu, select MODE MENU → PICTURE → CONTRAST, and press . “How to use the menus” (P. 28)

2 Press to adjust the contrast between +2 and –2.

- **To increase the contrast (+)**: The light and dark areas are defined more clearly, making the image look crisper.

- **To reduce the contrast (–)**: The light and dark areas become less defined, giving the image a softer impression. Use this setting when you want to edit images on a PC.

- When you have finished setting the contrast, press . Press again to exit the menu.
This function reduces the noise that is generated during long exposures. When shooting night scenes, shutter speeds become slower and noise tends to appear on images. When noise reduction is set to ON, the camera automatically reduces noise to produce clearer images. However, shooting time is approximately twice as long as usual. Noise reduction can only be used when the shutter speed is set slower than 1/2 sec.

The purpose of these pictures is to illustrate the effects of noise reduction. They are not actual pictures.

1 In the top menu, select MODE MENU → CAMERA → NOISE REDUCTION → ON, and press .

“How to use the menus” (P. 28)

• Press again to exit the menu.

Note

• When the mode is set, NOISE REDUCTION is fixed to ON.
• When NOISE REDUCTION is set to ON, the camera implements noise-reducing processes after each shot. For this reason, shooting time is approximately twice as long as usual. During this time, you cannot continue shooting.
• When NOISE REDUCTION is set to ON, sequential shooting ( , ) is not possible.
• This function may not work effectively with some shooting conditions or subjects.
• As the shutter speed is relatively slow, the use of a tripod is recommended.
Viewing still pictures

1 Press the (playback) button.
   • The monitor turns on and displays the last picture taken. (Single-frame playback)
   • Even if you press in the shooting mode, the camera enters the playback mode instantly.

2 Use the arrow pad to play back other pictures.
   • The mark is displayed on movies. P. 94

3 Press to cancel playback.
   • The monitor and camera turn off.
   • If you start playback while in the shooting mode in step 1, pressing again resumes the shooting mode. Pressing the shutter button halfway also resumes the shooting mode.

Note

• If no operation is performed for about 3 minutes, the camera automatically turns off.
Close-up playback

Pictures displayed on the monitor can be enlarged 1.5, 2, 2.5, 3, 3.5 or 4 times.

1 Display the picture you want to enlarge.
   ● Pictures with  cannot be enlarged.

2 Push the zoom lever toward  .
   ● Each time you push the zoom lever towards  , the picture is enlarged in steps of 1.5, 2, 2.5, 3, 3.5 or 4 times.
   ● Pressing the arrow pad while the enlarged picture is displayed moves the picture in the corresponding direction.

Pushing the zoom lever towards  returns to the picture to the original size (1x).

Note

● If slideshow is attempted during close-up playback, close-up playback is canceled.
● You cannot save the enlarged image.
Index display

This function lets you show several pictures on the monitor at the same time. This is useful when you want to quickly search a number of pictures to find a particular image. You can also select the number of frames displayed on the monitor.

“Selecting the number of pictures” (see below)

1. Push the zoom lever toward  during single-frame playback.
   - Pictures appear in the index display.
   - Pressing the arrow pad selects a frame during index display.
     - : Moves to the previous frame.
     - : Moves to the next frame.
     - : Jumps to the previous index display (the frames preceding the top left frame).
     - : Jumps to the next index display (the frames following the bottom right frame).

Pushing the zoom lever towards  returns to single-frame playback.

Selecting the number of pictures

This function lets you select the number of pictures in an index display from 4, 9 and 16.

1. In the top menu, select MODE MENU → SETUP →  → 4, 9 or 16, and press .
   “How to use the menus” (P. 28)
   - Press  again to exit the menu.
Slideshow

This function displays still pictures stored in the card one after another. Only the first frame of a movie is played back.

1 Display a still picture.

2 Press ( ) to select ( ) in the top menu.
   • The slideshow starts.
   • If slideshow is attempted during close-up playback, the picture returns to the original size (1x) and slideshow starts.

3 Press ( ) to stop the slideshow.
   • The slideshow will not stop until you cancel it by pressing ( ).

Note

- You are recommended to use the optional AC adapter when running a slideshow for a long period of time. If a battery is used, the camera will stop the slideshow after about 30 minutes and the camera will turn off.
Picture rotation

Pictures taken with the camera held vertically are displayed horizontally. This function lets you turn such pictures 90 degrees clockwise or counterclockwise so that they are displayed vertically.

1 Display the picture you want to rotate.
   - Pictures with " cannot be rotated.

2 In the top menu, select MODE MENU → PLAY → , and press .
   “How to use the menus” (P. 28)

3 Press to select +90° or –90°, and press .
   - The rotated image is saved.
   - Press again to exit the menu.

Note

• New picture orientations are saved even when the power is turned off.
• Protected pictures cannot be rotated. P. 100
Viewing movies

This function lets you play back or edit movies.

1 Display a picture with 🎥. P. 89

2 In the top menu, select MOVIE PLAY. “How to use the menus” (P. 28)

3 Press 🎥 to select MOVIE PLAYBACK. MOVIE
   PLAYBACK: Plays back movies.
   INDEX: Displays movies as indexes of 9 still frames. P. 96

4 Press 🎥 to start playback.
   • When movie playback ends, the display automatically returns to the beginning of the movie.
   • You can fast forward/reverse during playback.
     🎥: Fast forward
     Each press of the button changes the speed in the following sequence:
     x2 → x20 → x1
     🎥: Fast reverse
     Each press of the button changes the speed in the following sequence:
     x2 → x20 → x1
5 The MOVIE PLAYBACK screen is displayed. Press to select an item.

PLAYBACK : Plays back the entire movie again.

FRAME BY FRAME : Plays back the movie manually one frame at a time.

EXIT : Cancels movie playback.

6 Press to start your choice.

● When EXIT is selected, the MOVIE PLAYBACK screen appears. To exit, press .

How to use the arrow pad when FRAME BY FRAME is selected

: Displays the first frame of the movie.

: Displays the last frame of the movie.

: Every time you press the button, the next frame appears. The movie can be displayed continuously by holding the button down.

: Every time you press the button, the previous frame appears. The movie can be displayed continuously in reverse by holding the button down.

: Displays the MOVIE PLAYBACK screen.

• While the card access lamp blinks, the camera is reading the movie from the card. Reading of movies may take considerable time. Do not open the card cover while the card access lamp is blinking as this may cause not only the data on the card to be damaged, but may also render the card unusable.
INDEX — Creating an index

Movies can be displayed as indexes of 9 still frames. Indexes can be saved on the card as still pictures. Indexes are not stored in the same record mode as movies (see below).

<table>
<thead>
<tr>
<th>Record mode when the movie is shot</th>
<th>Record mode when stored as an index</th>
</tr>
</thead>
<tbody>
<tr>
<td>HQ</td>
<td>SQ2 (1024 x 768)</td>
</tr>
<tr>
<td>SQ</td>
<td>SQ2 (640 x 480)</td>
</tr>
</tbody>
</table>

3 Select INDEX in step 3 on page 94. Press ■.
- The INDEX screen appears.
- The card access lamp blinks while the movie is being accessed.

4 Press ◀ ▶ to select OK, and press ◄ ◄. 
- The index is saved on the card.
- When CANCEL is selected, the MOVIE PLAY screen appears.
- To exit the MOVIE PLAY screen, press ◄.

Note
- The interval between automatically selected frames varies depending on the recording time of the movie.
- INDEX is not available if there is not enough memory on the card.
Playback on a TV

Use the AV cable provided with the camera to play back recorded images on your TV. Both still pictures and movies can be played back.

1 Make sure that the TV and camera are turned off. Connect the A/V OUT jack on the camera to the video input terminal on the TV using the AV cable.

Connect to the TV’s video input (yellow) and audio input (white) terminals.

2 Turn the TV on and set it to the video input mode.
   • For details of switching to video input, refer to your TV’s instruction manual.

3 Press the (playback) button to turn the camera on.
   • The last picture taken is displayed on the TV. Use the arrow pad to select the picture you want to display.

TIPS

• The close-up playback, index display, slideshow and other playback functions can also be used on a TV screen.
• You are recommended to use the optional AC adapter when using the camera with a TV.

Note

• Make sure that the camera’s video output signal type is the same as the TV’s video signal type. “VIDEO OUT – Selecting the video signal type” (P. 122)
• The camera’s monitor turns off automatically when the AV cable is connected to the camera.
• The picture may appear off-center on the TV screen.
• When pictures are compressed in order to fit the entire picture on the TV screen, a black frame appears around the picture. If the picture is output to a video printer via the TV, the black frame may be printed.
Recording sound

Sound can be added to a still picture that you have already taken. You can also re-record over the sound that has already been recorded. Total recording time per picture is approximately 4 seconds.

1 Select the still picture you want to add sound to.

2 In the top menu, select MODE MENU → PLAY → .
   “How to use the menus” (P. 28)

3 Press to display START.

4 Turn the camera microphone toward the sound you want to record and press to start recording.
   • The BUSY bar is displayed during recording.

To obtain the optimum sound, the microphone should be placed no farther than 1 m (3.3 ft.) away from the subject.
• If you re-record the sound, the original sound is erased.
• You may not be able to record sound when there is insufficient card memory (the CARD FULL message is displayed).
• Sound recording may pick up camera noises, such as button operation or shutter movement.
• Once sound is added to a picture, it is not possible to erase only the sound. In this case, make a re-recording with silence.

Note
Editing still pictures

This function lets you change the image file size to 640 x 480 or 320 x 240 and stores the picture as a new file. Use this function to make the image file size smaller needed for instances such as attaching the picture to e-mail.

1 Display the still picture you want to edit.

2 In the top menu, select MODE MENU → EDIT → EDIT.  

   “How to use the menus” (P. 28)  
   ● The EDIT screen appears.

3 Press  to select the file size and press .  
   ● A bar is displayed to show editing progress and the screen returns to normal display.  
   ● To cancel resizing, select CANCEL and press .

Note

• In the following cases, EDIT is not available:
  – The card does not have enough memory  
  – Movie mode  
  – Pictures recorded in TIFF  
  – Pictures processed on a computer  
• The file size 640 x 480 cannot be selected for a picture shot in 640 x 480.
Protecting pictures

It is highly recommended that you protect important pictures to avoid accidentally erasing them. Protected pictures cannot be erased by the single-frame/all-frame erase function.

1 Display the picture you want to protect.

2 Press the button. The picture is now protected.
   - The mark appears on the protected picture.
   - To cancel protection, press again.

Note

Protected pictures cannot be deleted with the single-frame/all-frame erase functions, but they can be deleted with the FORMAT function.
Erasing pictures

Recorded pictures can also be erased. You can select either single-frame erase or all-frame erase.

Notes:
• You cannot erase pictures that are protected. Cancel protection before erasing such pictures.
• Once erased, pictures cannot be restored. Check each picture before erasing to avoid accidentally erasing pictures you want to keep.
  “Protecting pictures” (P. 100)

Single-frame erase

This function only erases the picture displayed on the monitor. Erasing further pictures must be done one-by-one if using this function.

1 Display the picture you want to erase.

2 Press the (erase) button.
   ● The ERASE screen is displayed.

3 Press to select YES.
   ● To cancel erasing, select NO and press .

4 Press to erase the picture.
   ● The picture is erased and the menu disappears.
All-frame erase

This function erases all still pictures and movies on the card.

1 In the top menu, select MODE MENU → CARD → CARD SETUP and press .
   “How to use the menus” (P. 28)

2 Press to select ALL ERASE, then press .

3 Press to select YES, then press .
   The BUSY bar is displayed to show the progress of erasing and all the pictures are erased.
This function lets you save the current camera settings when the power is turned off. Available functions for ALL RESET are listed on the next page. The ALL RESET setting (ON/OFF) applies to all the modes. If ALL RESET is set in one mode, this setting applies to all the other modes, both shooting and playback.

**ON**
All settings are returned to the factory default settings after the power is turned off.

Ex: When ALL RESET is set to ON, even if you change the record mode setting to SQ1, it will return to HQ (factory default setting) next time the camera is turned on.

**OFF**
The settings made before the power is turned off are saved.

1. In the top menu, select MODE MENU → SETUP → ALL RESET → ON or OFF, and press .
   - “How to use the menus” (P. 28)
   - Press again to exit the menu.

---

**Note**
- The settings for MY MODE SETUP and functions on the SETUP tab in MODE MENU (ALL RESET, , , etc.) are not returned to the factory default settings even when ALL RESET is set to ON.
### ALL RESET: Functions that reset to factory default settings when set to ON

<table>
<thead>
<tr>
<th>Functions</th>
<th>Factory default settings</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCENE</td>
<td><img src="image1.png" alt="Diagram" /></td>
<td>P. 36</td>
</tr>
<tr>
<td>FNo</td>
<td>F2.8</td>
<td>P. 58</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
<td>P. 59</td>
</tr>
<tr>
<td>MONITOR</td>
<td>ON</td>
<td>P. 45</td>
</tr>
<tr>
<td>ZOOM</td>
<td>38mm</td>
<td>P. 51</td>
</tr>
<tr>
<td>FLASH MODE*¹</td>
<td>AUTO*²</td>
<td>P. 53</td>
</tr>
<tr>
<td>BRIGHTNESS*¹</td>
<td>OFF</td>
<td>P. 62, 63</td>
</tr>
<tr>
<td>SHUTTER MODE*¹</td>
<td>OFF</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>DRIVE</td>
<td></td>
<td>P. 68</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>P. 83</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF</td>
<td>P. 88</td>
</tr>
<tr>
<td>DIGITAL ZOOM*¹</td>
<td>OFF</td>
<td>P. 52</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>OFF</td>
<td>P. 61</td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>OFF</td>
<td>P. 78</td>
</tr>
<tr>
<td>(still pictures)</td>
<td>OFF</td>
<td>P. 75</td>
</tr>
<tr>
<td>(movies)</td>
<td>ON</td>
<td>P. 77</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF</td>
<td>P. 74</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
<td>P. 111</td>
</tr>
<tr>
<td>(image mode)</td>
<td>OFF</td>
<td>P. 113</td>
</tr>
<tr>
<td>WB</td>
<td>AUTO</td>
<td>P. 85</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>±0</td>
<td>P. 86</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>±0</td>
<td>P. 87</td>
</tr>
</tbody>
</table>

*1 Even when ALL RESET is set to OFF, settings may not be saved depending on the shooting mode.

*2 The factory default setting varies depending on the shooting mode.
Two shortcut menus (A, B) on the top menu can be replaced with the functions listed in the table below when the camera is in a shooting mode other than AUTO and 📸. This is useful when you want to go quickly to frequently-used functions.

**Default setting**

A: 🌿/🕒
B: ⏺️

<table>
<thead>
<tr>
<th>Available menu functions</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCENE</td>
<td>P. 36</td>
</tr>
<tr>
<td>🌿/🕒</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>DRIVE</td>
<td>P. 68</td>
</tr>
<tr>
<td>ISO</td>
<td>P. 83</td>
</tr>
<tr>
<td>🌿/🕒</td>
<td>P. 57</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>P. 88</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>P. 52</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>P. 61</td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>P. 78</td>
</tr>
<tr>
<td>🌿 (still pictures)</td>
<td>P. 75</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Available menu functions</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌿</td>
<td>P. 64</td>
</tr>
<tr>
<td>PANORAMA</td>
<td>P. 71</td>
</tr>
<tr>
<td>2 IN 1</td>
<td>P. 73</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>P. 74</td>
</tr>
<tr>
<td>INFO</td>
<td>P. 111</td>
</tr>
<tr>
<td>🌿/🕒</td>
<td>P. 113</td>
</tr>
<tr>
<td>⏺️</td>
<td>P. 79</td>
</tr>
<tr>
<td>WB</td>
<td>P. 85</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>P. 86</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>P. 87</td>
</tr>
</tbody>
</table>
Registering functions to the shortcut menus

Assign functions to the A and B positions on the top menu.

1. In the top menu, select MODE MENU → SETUP → SHORT CUT, and press .
   “How to use the menus” (P. 28)

2. Press to select A or B, then press .

3. Press to select the function you want to register, then press.
   ● The function is registered in the shortcut menu.
   ● Press again to exit the menu.
Using the shortcut menu

1. Press ☐ to display the top menu.
   - The function you have registered in the shortcut menu appears on the top menu.

2. Press ◄ or ► to select the function.
   - The monitor jumps directly to the setting screen for that menu function.

Ex: When SCENE is assigned to shortcut menu A

Press this button.

Pressing ◄ takes you directly to the SCENE screen.

Note

- You cannot assign different functions to the shortcut menus for each mode.
This lets you customize function settings for shooting and register them in the \( \text{M} \) mode on the mode dial. When the camera is in P, A, S or M mode, you can also register the current settings in the \( \text{M} \) mode so that they can be called up any time for shooting with this mode.

When the mode dial is set to \( \text{M} \), your customized settings are activated.

Available functions for MY MODE SETUP and factory default settings

<table>
<thead>
<tr>
<th>Functions</th>
<th>Factory default settings</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>P/A/S/M</td>
<td>P</td>
<td>P. 37, 38</td>
</tr>
<tr>
<td>FNo</td>
<td>F2.8</td>
<td>P. 58</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
<td>P. 59</td>
</tr>
<tr>
<td>MONITOR(^*1)</td>
<td>ON</td>
<td>P. 45</td>
</tr>
<tr>
<td>ZOOM(^*2)</td>
<td>38 mm</td>
<td>P. 51</td>
</tr>
<tr>
<td>FLASH MODE</td>
<td>AUTO</td>
<td>P. 53</td>
</tr>
<tr>
<td>( \text{\textcircled{}} )/( \text{\textdiamond} )</td>
<td>OFF</td>
<td>P. 62, 63</td>
</tr>
<tr>
<td>( \text{\textdiamond} )/( \text{\textcircled{}} )</td>
<td>OFF</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>DRIVE</td>
<td></td>
<td>P. 68</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>P. 83</td>
</tr>
<tr>
<td>( \text{\textdiamond} )( \downarrow )</td>
<td>0.0</td>
<td>P. 57</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF</td>
<td>P. 88</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Functions</th>
<th>Factory default settings</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
<td>P. 52</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>OFF</td>
<td>P. 61</td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>OFF</td>
<td>P. 78</td>
</tr>
<tr>
<td>(still pictures)</td>
<td>OFF</td>
<td>P. 75</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF</td>
<td>P. 74</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
<td>P. 111</td>
</tr>
<tr>
<td>( \text{\textcircled{}} )/( \text{\textdiamond} )</td>
<td>OFF</td>
<td>P. 113</td>
</tr>
<tr>
<td>HQ</td>
<td></td>
<td>P. 79</td>
</tr>
<tr>
<td>WB</td>
<td>AUTO</td>
<td>P. 85</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>±0</td>
<td>P. 86</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>±0</td>
<td>P. 87</td>
</tr>
</tbody>
</table>

\(^*1\) This sets the monitor to on or off when the camera is turned on.

\(^*2\) Available zoom positions are 38/50/70/114 mm (those numbers are 35 mm film equivalent).
MY MODE SETUP — Registering customized settings in the \( \text{MY} \) mode

1. In the top menu, select MODE MENU → SETUP → MY MODE SETUP, and press \( \text{SET} \) .
   “How to use the menus” (P. 28)

2. Press \( \text{SET} \) to select an item you want to set, then press \( \text{SET} \) .
   - **CURRENT** Registers the current camera settings.
   - **RESET** Restores the factory default settings.
   - **CUSTOM** Registers settings one by one.
MY MODE SETUP — Registering customized settings in \( \text{My} \) mode

3 When selecting CURRENT in Step 2
Press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \) to select SET, then press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \).
- The current camera settings are registered in the \( \text{My} \) mode.

When selecting RESET in Step 2
Press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \) to select ALL RESET, then press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \).
- The registered settings are canceled to return to the factory default settings.

When selecting CUSTOM in Step 2
Press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \) to select the item you want to register in the \( \text{My} \) mode, then press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \).
- Available CUSTOM items are “Available functions for MY MODE SETUP and factory default settings” (P. 108)
- Press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \) to change the setting, then press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \).
  - The setting is saved.
  - You can also change the other CUSTOM settings.

4 When you have made all the settings you want, press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \).
- The screen displayed in Step 2 appears.
- Press \( \texttt{\textit{\textbf{INPUT}} \text{\textit{\textbf{INPUT}}}} \) again to exit the menu.

\( \text{Note} \)
- When CURRENT is selected, the zoom position is set to one of the four zoom positions available in MY MODE SETUP. The value closest to the current zoom position will be automatically selected.
This function lets you display detailed shooting information on the monitor for 3 seconds. For details on the information displayed, refer to “Monitor indications” (P. 10).

1 In the top menu, select MODE MENU → CAMERA → INFO → ON or OFF. Press .
   “How to use the menus” (P. 28)
   • Even when INFO is set to OFF, the detailed information is displayed for around 3 seconds after you have made the function settings.
   • Press again to display the menu.

Example: Indications during shooting (for still pictures)
INFO — Displaying shooting information on the monitor

Available modes

Press \( \) in the top menu to display the full amount of shooting information on the monitor (ON).

- To turn INFO off, press \( \) again to bring up the top menu and press \( \) (OFF).

Example: Indications during still picture playback

![Example Image]

When INFO is OFF

When INFO is ON

Note

- If the picture has been taken with a different camera, not all the information may be displayed even when INFO is set to ON.
- If \( \) is set to ON, the histogram is displayed regardless of whether INFO is set to ON or OFF.
Histogram display — Displaying the brightness distribution of still pictures

While you are taking still pictures or playing them back, you can display a histogram on the monitor that shows the brightness and contrast of your subject. You can also display the darkest shadows and brightest highlights directly on the image. Checking the histogram during shooting enables more precise exposure control. During playback, you can check the brightness and contrast of recorded pictures.

The histogram display can be set separately for shooting mode and playback mode.

Histogram display during shooting

When the image is bright

When the image is dark

If the peak fills too much of the right frame, the image will appear mostly white.

If the peak fills too much of the left frame, the image will appear mostly black.

Histogram display during playback
Histogram display — Displaying the brightness distribution of still pictures

Useful functions

1. In the top menu, select MODE MENU → CAMERA → ON, then press ( ).
   - “How to use the menus” (P. 28)
   - Press ( ) again to exit the menu.

Available modes

1. Press ( ) in the top menu to display the histogram.
   - To turn the histogram off, press ( ) again to bring up the top menu and press ( ) (OFF).

Available modes

Note

- The histogram is not displayed in the following situations even if histogram display is set to ON:
  - In the M mode, during panorama shooting, during two-in-one (2 IN 1) shooting.
  - You can turn the histogram on and off during exposure compensation.
    - “Exposure compensation” (P. 84)
  - The histogram displayed during shooting may differ from that displayed during playback.
  - It may not be possible to display a histogram for pictures taken with another camera.
This function lets you format a card. Formatting prepares cards to receive data. Olympus CAMEDIA-brand cards are highly recommended for use with this camera. If you are going to use non-OLYMPUS cards or cards formatted by other devices such as a computer, you must format them with the camera before use. All data stored on the card, including protected pictures, is erased when the card is formatted. When formatting a used card, confirm there are no pictures that you still want to keep on the card.

1 In the top menu, select CARD SETUP.
   🔄 “What are the menus?” (P. 27)

1 In the top menu, select MODE MENU → CARD → CARD SETUP. Press 📷. Press 📷 to select FORMAT, then press 📷. 🔄 “How to use the menus” (P. 28)
2 Press ◀ to select YES.

3 Press ◀ to start formatting.
   • The BUSY bar is displayed to show the progress of formatting.

Note
• Do not perform any of the following actions during formatting as they may render the card unusable:
  Open the battery/card compartment cover, remove the battery, connect or disconnect the AC adapter (regardless of whether or not the battery is loaded in the camera).
Monitor brightness adjustment

This function lets you adjust the brightness of the monitor.

Available modes

1. In the top menu, select MODE MENU → SETUP → , and press .
   “How to use the menus” (P. 28)

2. Press to adjust the brightness of the monitor, and when you have set the desired level, press .
   ● Pressing brightens the monitor, and pressing darkens it.
   ● Press again to exit the menu.

Beep — Setting the warning tone

You can select the volume of the beep sound used for warnings from OFF, LOW, or HIGH. You can turn the sound off completely by setting OFF.

Available modes

1. In the top menu, select MODE MENU → SETUP → → OFF, LOW or HIGH. Press .
   “How to use the menus” (P. 28)
   ● Press again to exit the menu.
SHUTTER SOUND — Setting the shutter sound

You can select from either one of 2 shutter sounds emitted when the shutter button is pressed. You can also select the volume of each kind of sound from LOW or HIGH. The factory default settings are 1 for the kind of sound and LOW for the volume. Select OFF when you want to turn the sound off completely.

1. In the top menu, select MODE MENU → SETUP → SHUTTER SOUND, and press .
   “How to use the menus” (P. 28)

2. Select 1 or 2 and press . Then select LOW or HIGH and press .
   • To turn the sound off completely, select OFF and press .
   • Press repeatedly until the menu disappears.
VOLUME — Adjusting the playback volume

You can adjust the volume when playing back a still picture with sound or a movie. You can select the volume from LOW or HIGH. Select OFF when you want to turn the sound off completely.

1 In the top menu, select MODE MENU → SETUP → VOLUME, and press .
   ⇨ “How to use the menus” (P. 28)

2 Press  to select the volume level, then press .
   • Press  again to exit the menu.
You can select whether to display the startup/shutdown screen or adjust the sound volume when the power is turned on/off.

1. In the top menu, select MODE MENU → SETUP → PW ON/OFF SETUP, and press .

   “How to use the menus” (P. 28)

2. Press \( \Rightarrow \) to select SCREEN, then press . Press \( \Rightarrow \) to select OFF or ON, then press .

   OFF  No picture is displayed.
   ON   The picture is displayed.

3. Press \( \Rightarrow \) to select VOLUME, then press . Press \( \Rightarrow \) to select OFF, LOW or HIGH, then press .
   - To turn off the sound completely, select OFF.
   - When you have made all the settings you want, press \( \Rightarrow \). Press \( \Rightarrow\) repeatedly until the menu disappears.
Useful functions

REC VIEW — Checking the picture immediately after shooting

You can select whether to display the picture you have just taken on the monitor.

ON : The picture being recorded to the card is displayed. This is useful for making a brief check of the picture you have just taken. You can release the shutter during REC VIEW.

OFF : The picture being recorded to the card is not displayed. This is useful when you want to compose your next shot using the monitor while the previous picture is being recorded.

1 In the top menu, select MODE MENU → SETUP → REC VIEW → OFF or ON, and press ．

“How to use the menus” (P. 28)

Press  again to exit the menu.
SLEEP — Sleep timer

The camera automatically enters the sleep mode (idle mode) if the time you have set has passed with no operations being performed. To activate the camera again, operate any button (press the shutter button or arrow pad, etc.).

Available modes

1. In the top menu, select MODE MENU → SETUP → SLEEP, then select a setting from the following: 30SEC, 1MIN, 3MIN, 5MIN or 10MIN. Press .

   “How to use the menus” (P. 28)

   • Press again to exit the menu.

Note

• The camera always turns off if the camera is left in playback mode for about 3 minutes.

VIDEO OUT — Selecting the video signal type

You can select NTSC or PAL according to your TV’s video signal type. Select the video signal type before connecting the AV cable. If you use the wrong video signal type, you will not be able to play back the recorded pictures properly on your TV.

Available modes

1. In the top menu, select MODE MENU → SETUP → VIDEO OUT → NTSC or PAL, and press .

   “How to use the menus” (P. 28)

   • Press again to exit the menu.

TV video signal types & main regions

Check the video signal type on your region before using the camera.

NTSC: North America, Japan, Taiwan, Korea
PAL: European countries, China
When you take a picture, the camera assigns it a unique file name and saves it in a folder. The folder and file name can later be used for file handling on a computer. File names are assigned as shown in the illustration below.

### File name settings

**AUTO**

Even when a new card is inserted, the folder numbers are retained from the previous card. If the new card contains an image file whose file number coincides with one saved on the previous card, the new card’s file numbers start at the number following the highest number on the previous card.

**RESET**

When a new card is inserted, folder numbers start at 100 and file numbers start at 0001. If a card containing images is inserted, the file numbers start at the number following the highest file number on the card.

1. **In the top menu, select MODE MENU → SETUP → FILE NAME → AUTO or RESET.**
2. Press ②.
   - “How to use the menus” (P. 28)
   - Press ② again to exit the menu.

---

**Note**

- When both the Folder and File No. reach their respective maximum number (999/9999), it is not possible to store additional pictures even if the card is not full. No more pictures can be taken. Replace the card with a new one.
The PIXEL MAPPING feature allows the camera to check and adjust the CCD and image processing functions. It is not necessary to operate this function frequently. Approximately once a year is recommended. After using the monitor or taking continuous shots, wait for at least one minute before using the PIXEL MAPPING function to ensure that it operates correctly.

1. In the top menu, select MODE MENU → SETUP → PIXEL MAPPING, and press .
   • START appears.

2. Press .
   • The BUSY bar is displayed during PIXEL MAPPING.
   • When PIXEL MAPPING is finished, press to exit the menu.

Note: If you accidentally turn the camera off during PIXEL MAPPING, start again from Step 1.
How to print pictures

Print reservation allows you to save printing data (the number of prints and the date/time information) with the pictures stored on the card. With print reservation, you can print out pictures easily either at home using a personal DPOF-compatible printer or at a print shop that supports DPOF. DPOF is a standard format used to record automatic print information from digital cameras. You can print out pictures automatically, at home or in a print shop, by storing such data as which pictures you wish to print and the number of prints on a card.

Pictures taken with print reservation can be printed using the following procedures.

**Printing using a DPOF-compatible print shop.**
You can print the pictures using the print reservation data.

**Printing using a DPOF-compatible printer.**
Printing is possible directly from a card containing print reservation data without using a PC. For more details, refer to the printer’s instruction manual. A PC card adapter may also be necessary.
How to print pictures

- Picture size and printing

The resolution of a computer/printer is generally based on the number of dots (pixels) per square inch. This is called dpi (dots per inch). The higher the dpi value, the better the printed results. Keep in mind, however, that the dpi of the picture does not change. This means that when you print an image with a higher resolution, the size of the printed picture will be smaller. Although you can print magnified images, picture quality will decrease. If you want to print large, high-quality pictures, set the record mode as high as possible when taking the pictures. “Record mode” (P. 79)

- Note

- DPOF reservations set by another device cannot be changed by this camera. Make changes using the original device.
- If a card contains DPOF reservations set by another device, entering reservations using this camera may overwrite the previous reservations.
- If there is not enough space in the card memory, CARD FULL will be displayed and you may not be able to enter the reservation data.
- You can make DPOF print reservations for up to 999 images per card.
- Even if an image appears with the message “PICTURE ERROR”, it may be possible to make print reservations. In this case, the print reservation icon ( ) does not appear when the image is displayed for full view. ( ) appears when multiple images are displayed (index display), allowing you to confirm the print reservation.
- Not all functions may be available on all printers or at all photo labs.
- Some TIFF images cannot be printed.
- Print reservation may take considerable time when saving printing data to a card.
Applying print reservation to a card

1. Play back a still picture.
   - You cannot enter (print reservation) on pictures with ( ).

2. In the top menu, select MODE MENU → PLAY →  .
   - “How to use the menus” (P. 28)
   - If print reserve data is already stored on the card, the PRINT ORDER SETTING screen appears. You can then reset the data or keep it. If RESET is selected, all print reserve data is canceled.

3. Press to select or . Press .
   - : Performs print reservation for only selected pictures and sets the number of prints and date/time. Go to step 4.
   - : Performs print reservation for all the pictures stored on the card and sets date/time. makes one print for each frame. Go to step 5.

4. When you selected in step 3
   Press to select a frame you want to print.
   - If print reservation has already been applied, the number of prints currently set is displayed.
Applying print reservation to a card

Press \( \circ \circ \) to set \( \square \) x (number of prints).
- Up to 10 can be set. 0 cancels print reservation.

When setting is complete, press \( \circ \).  
- The \( \circ \) screen appears.

5 Press \( \circ \circ \) to select NO, DATE or TIME and press \( \circ \).  
NO : Prints the frame without date/time.  
DATE : Prints the frame together with the shooting date.  
TIME : Prints the frame together with the shooting time.

6 Check the number of print reservation frames, the total number of prints, and date/time printing data. Press \( \circ \circ \) to select SET and press \( \circ \).  
- CANCEL clears all print reserve data.

7 Press \( \circ \) to finish print reservation.
9 Direct printing (PictBridge)

Using the direct printing function

By connecting the camera to a PictBridge-compatible printer with the USB cable, you can print out recorded pictures directly. With the camera connected to the printer, select the pictures you want to print and the number of prints on the camera’s monitor. It is also possible to print out pictures using the print reservation data. “How to print pictures” (P.125)

To find out if your printer is compatible with PictBridge, refer to the printer’s instruction manual.

What is PictBridge? … It is a standard that allows connection of digital cameras and printers made by different manufacturers and enables direct printing.

STANDARD … All printers that support PictBridge have standard print settings. By selecting STANDARD on the settings screens (P. 132 to 139), you can print images according to these settings. For details on your printer’s standard settings, refer to the printer’s instruction manual or contact the printer manufacturer.

TIPS
• For details of printing paper types, ink cassettes, etc., refer to the printer’s instruction manual.

Note
• You are recommended to use the optional AC adapter when printing pictures. If you use the battery, make sure that it is fully charged. If the camera stops operating while communicating with the printer, the printer may malfunction or image data may be lost.
• Movies cannot be printed.
• The camera will not enter sleep mode when connected to the USB cable.
Connecting the camera to a printer

Use the USB cable provided to connect the camera to a PictBridge-compatible printer.

1 Turn the printer on and plug the printer end of the USB cable into the printer’s USB port.
   - For details on how to turn the printer on and the position of the USB port, refer to the printer’s instruction manual.

2 Plug the USB cable into the camera’s USB connector.
   - The camera turns on automatically.
   - The camera’s monitor turns on and the selection screen for the USB connection is displayed.

3 Press to select PRINT, then press .
   - ONE MOMENT is displayed and the camera and printer are connected. The PRINT MODE SELECT screen is displayed on the monitor. Make the print settings on the camera’s monitor. Go to “Printing pictures” (P. 131).

- If PC is selected in step 3, the PRINT MODE SELECT screen is not displayed. If the screen is not displayed after several minutes, unplug the USB cable from the camera and start again from step 1.
When the camera is connected to a PictBridge-compatible printer, the PRINT MODE SELECT screen is displayed on the monitor. Use this screen to select the print mode. You can choose from the following print modes.

**PRINT**
Prints the selected picture.

**ALL PRINT**
Prints all the pictures stored on the card.

**MULTI PRINT**
Prints one picture in multiple layout format.

**ALL INDEX**
Prints an index of all the pictures stored on the card.

**PRINT ORDER**
Prints the pictures according to the print reservation data on the card. If no print reservations have been made, this option is not available.

---

**Print modes and the settings**

The available print modes and settings such as paper size vary depending on the type of printer.

For details, refer to the printer’s instructions.
Printing basics

Print an image using the most simple printing method. You can make a print of each image. The date and file name are not printed.

1. In the PRINT MODE SELECT screen, press \( \Rightarrow \) to select PRINT, then press \( \Rightarrow \).
   - The PRINT PAPER screen is displayed.

2. Press \( \Rightarrow \) to select the paper size, then press \( \Rightarrow \).
   - When the PRINT PAPER screen is not displayed, SIZE, BORDERLESS and PICS/SHEET are set to STANDARD. Go to step 4.

3. Use \( \Rightarrow \) to select framed or unframed, then press \( \Rightarrow \). Go to step 5.
   - OFF ( ) The image is printed inside a blank frame.
   - ON ( ) The image is printed filling the entire page.

4. Press \( \Rightarrow \) to select the picture you want to print. Press \( \Rightarrow \).
   - The PRINT screen is displayed.
5 Press ☐ to select OK, then press ☒ .
- Printing starts.
- If you select CANCEL and press ☐, the monitor returns to the PRINT MODE SELECT screen.
- When printing is finished, the monitor returns to the screen in step 4. Repeat steps 4 and 5 to continue printing.

PRINT mode/MULTI PRINT mode

1 In the PRINT MODE SELECT screen, press ☐ to select PRINT or MULTI PRINT, then press ☒ .
- The PRINT PAPER screen is displayed.

2 Press ☐ to select the paper size, then press ☒ .

- **PRINT mode** Go to Step 3.
- **MULTI PRINT mode** Go to Step 4.
- When the PRINT PAPER screen is not displayed, SIZE, BORDERLESS and PICS/SHEET are set to ☐ STANDARD.
  Go to step 5.
3 Use \( \circ \) to select framed or unframed, then press \( \circ \). Go to step 5.
   - OFF ( \( \square \) ) The image is printed inside a blank frame.
   - ON ( \( \square \) ) The image is printed filling the entire page.

4 Press \( \circ \) to select PICS/SHEET, then press \( \circ \).
   - PICS/SHEET depends on the paper size set in Step 2 and the capabilities of your printer.

5 Press \( \circ \) to select the picture you want to print.
   - Push the zoom lever toward W to display the pictures in index format. You can then select the pictures you want to print from the index.

6 Select the print reservation method.
   - SINGLE PRINT Makes a single-frame print reservation for the selected picture according to standard settings.
   - MORE Sets the number of prints of the selected picture in the print reservation data. You can also add the date or file name.
Set a SINGLE PRINT reservation

Press 📷.

- Press 📷 when the picture with 📷 is displayed to cancel the reservation.

Set MORE print reservations

1. Press 📷.
   - The PRINT INFO screen is displayed.

2. Press 📷 to select the item you want to set, then press 📷.
   - Press 📷 to select the item, then press 📷.

- Sets the number of prints. You can select up to 10 prints.
- DATE (📅) If you select WITH, pictures are printed with the date and time.
- FILE NAME (🚀) If you select WITH, pictures are printed with the file name.

- DATE and FILE NAME are not available in MULTI PRINT mode.
3 When you have finished all the settings for MORE, press \( \text{\(\ rue\)} \).
- The screen displayed in Step 5 appears.
- To print more than one picture in PRINT and/or MULTI PRINT mode, repeat Steps 5 and 6 and make single and/or multiple print reservations for all the pictures you want to print.
- \( \text{\(\ rue\)} \) is displayed in MULTI PRINT mode.

7 Press \( \text{\(\ rue\)} \).
- The PRINT screen is displayed.

8 Print the pictures.
- Press \( \text{\(\ rue\)} \) to select OK or CANCEL, then press \( \text{\(\ rue\)} \).
  - OK Printing starts.
  - CANCEL The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.

- When printing is finished, the monitor returns to the PRINT MODE SELECT screen.
  “Exiting direct printing” (P. 141)

To cancel printing
- Pressing \( \text{\(\ rue\)} \) during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press \( \text{\(\ rue\)} \) to select CANCEL, then press \( \text{\(\ rue\)} \).
ALL PRINT mode

1 In the PRINT MODE SELECT screen, press \(\langle\) to select ALL PRINT, then press \(\rangle\).  
   * The PRINT PAPER screen is displayed.

2 Press \(\langle\) to select the paper size, then press \(\rangle\).  
   * When the PRINT PAPER screen is not displayed, SIZE and BORDERLESS are set to \(\langle\) STANDARD. Go to Step 4.

3 Use \(\langle\) to select framed or unframed, then press \(\rangle\).  
   - OFF (\(\langle\)) The image is printed inside a blank frame.  
   - ON (\(\rangle\)) The image is printed filling the entire page.  
   * The PRINT INFO screen is displayed.
Printing pictures

4 Press \(\text{\(\uparrow\uparrow\downarrow\)}\) to select the item you want
to set, then press \(\text{\(\uparrow\)}\).
- Press \(\text{\(\uparrow\uparrow\downarrow\)}\) to select the item, then press
\(\text{\(\uparrow\)}\).
- If PRINT INFO cannot be set with your
printer, go to Step 6.
- Only one print of each image can be made at a time.
  
**DATE (\(\text{\(\uparrow\)}\))** If you select WITH, pictures are printed with the date
and time.

**FILE NAME (\(\text{\(\uparrow\downarrow\downarrow\)}\))** If you select WITH, pictures are printed with the file
name.

5 Press \(\text{\(\uparrow\)}\).
- The PRINT screen is displayed.

6 Print the pictures.
- Press \(\text{\(\uparrow\uparrow\downarrow\)}\) to select OK or CANCEL,
then press \(\text{\(\uparrow\)}\).

  **OK** Printing starts.
  **CANCEL** The settings are canceled and
the monitor returns to the PRINT
MODE SELECT screen.

- When printing is finished, the monitor returns
to the PRINT MODE SELECT screen.

  “Exiting direct printing” (P. 141)

- **To cancel printing**

  Pressing \(\text{\(\uparrow\uparrow\downarrow\)}\) during print data transfer displays
the screen for selecting whether to continue or
cancel printing. To cancel printing, press \(\text{\(\uparrow\uparrow\downarrow\)}\)
to select CANCEL, then press \(\text{\(\uparrow\)}\).
ALL INDEX mode/PRINT ORDER mode

1. In the PRINT MODE SELECT screen, press \( \text{ALL INDEX} \) or \( \text{PRINT ORDER} \), then press \( \text{GO} \).
   - The PRINT PAPER screen is displayed.

2. Press \( \text{SIZE} \) to select the paper size, then press \( \text{GO} \).
   - When the PRINT PAPER screen is not displayed, SIZE and BORDERLESS are set to \( \text{STANDARD} \) (printer’s factory default setting). Go to Step 4.

3. Use \( \text{BORDERLESS} \) to select framed or unframed, then press \( \text{GO} \).
   - OFF ( ) The image is printed inside a blank frame.
   - ON ( ) The image is printed filling the entire page.
   - The print screen is displayed.
   - BORDERLESS is not available in ALL INDEX mode. Press \( \text{GO} \) and go to Step 4.
4 Print the pictures.
   - Press to select OK or CANCEL, then press .
     OK Printing starts.
     CANCEL The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.

   - When printing is finished, the monitor returns to the PRINT MODE SELECT screen.
     → “Exiting direct printing” (P. 141)

To cancel printing

Pressing during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press to select CANCEL, then press .
Exiting direct printing

When you have finished printing, disconnect the camera from the printer.

1. In the PRINT MODE SELECT screen, select (4).
   - The message is displayed.

2. Remove the USB cable from the camera.
   - The camera turns off.

3. Remove the USB cable from the printer.
If an error code appears on the camera’s monitor during direct print setting or printing, see the following table. For more details, refer to the printer’s instruction manual.

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO CONNECTION</td>
<td>The camera is not connected to the printer correctly.</td>
<td>Disconnect the camera and connect it again correctly.</td>
</tr>
<tr>
<td>NO PAPER</td>
<td>There is no paper in the printer.</td>
<td>Load some paper in the printer.</td>
</tr>
<tr>
<td>NO INK</td>
<td>The printer has run out of ink.</td>
<td>Replace the ink cartridge in the printer.</td>
</tr>
<tr>
<td>JAMMED</td>
<td>The paper is jammed.</td>
<td>Remove the jammed paper.</td>
</tr>
<tr>
<td>SETTINGS CHANGED</td>
<td>The printer’s paper cassette has been removed or the printer has been manipulated while making settings on the camera.</td>
<td>Do not manipulate the printer while making settings on the camera.</td>
</tr>
<tr>
<td>PRINT ERROR</td>
<td>There is a problem with the printer and/or camera.</td>
<td>Turn off the camera and printer, then turn them on again.</td>
</tr>
</tbody>
</table>

**TIPS**
- If an error code other than those shown above is displayed, refer to “Error codes” (P. 143).
## 10 Miscellaneous

### Error codes

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![NO CARD]</td>
<td>The card is not inserted, or it cannot be recognized.</td>
<td>Insert a card or insert a different card. If the problem persists, format the card. If the card cannot be formatted, it cannot be used.</td>
</tr>
<tr>
<td>![CARD ERROR]</td>
<td>There is a problem with the card.</td>
<td>Use a different card. Insert a new card.</td>
</tr>
<tr>
<td>![WRITE PROTECT]</td>
<td>Writing to the card is prohibited.</td>
<td>The recorded image has been protected (read-only) on a PC. Download the image to a PC and cancel the read-only setting.</td>
</tr>
<tr>
<td>![CARD FULL]</td>
<td>The card is full. No more pictures, movies or information such as resizing can be recorded.</td>
<td>Replace the card or erase unwanted pictures. Before erasing, download important images to a PC.</td>
</tr>
<tr>
<td>![NO PICTURE]</td>
<td>There are no pictures on the card.</td>
<td>The card contains no pictures. Record pictures.</td>
</tr>
</tbody>
</table>
## Monitor indication

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Picture Error" /> <strong>PICTURE ERROR</strong></td>
<td>There is a problem with the selected picture and it cannot be played back on this camera.</td>
<td>Use image processing software to view the picture on a PC. If that cannot be done, the image file is damaged.</td>
</tr>
<tr>
<td><img src="image" alt="Card Cover Open" /> <strong>CARD-COVER OPEN</strong></td>
<td>The battery/card compartment cover is open.</td>
<td>Close the battery/card compartment cover.</td>
</tr>
<tr>
<td><img src="image" alt="Card Setup" /> <strong>CARD SETUP</strong></td>
<td>The card is not formatted.</td>
<td>Format the card. All data on the card is deleted.</td>
</tr>
<tr>
<td><img src="image" alt="Date" /> <strong>Y/M/D</strong></td>
<td>The first time the camera is used or when it is left with the battery removed for a long time, the default date and time setting are restored.</td>
<td>Set the date and time.</td>
</tr>
</tbody>
</table>
# Troubleshooting

## Preparatory operations

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The camera does not turn on or function buttons do not respond.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The power is off.</td>
<td>Open the lens barrier to turn on the camera.</td>
<td>P. 21</td>
</tr>
<tr>
<td>The battery is exhausted.</td>
<td>Charge the battery.</td>
<td>P. 16</td>
</tr>
<tr>
<td>The battery is temporarily unable to function because of the cold.</td>
<td>Warm the battery by putting it in your pocket for a while.</td>
<td>—</td>
</tr>
<tr>
<td>The camera is in the sleep mode.</td>
<td>Operate the camera (press the shutter button or the zoom lever).</td>
<td>P. 22</td>
</tr>
<tr>
<td>The camera is connected to a PC.</td>
<td>The camera will not operate while it is connected to a PC or printer.</td>
<td>—</td>
</tr>
</tbody>
</table>

## Shooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>No picture is taken when the shutter button is pressed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The lens barrier is closed.</td>
<td>Open the lens barrier.</td>
<td>P. 21</td>
</tr>
<tr>
<td>The battery is exhausted.</td>
<td>Charge the battery.</td>
<td>P. 16</td>
</tr>
<tr>
<td>The flash has not finished charging.</td>
<td>Remove your finger from the shutter button, and wait until the orange lamp stops blinking. Press the shutter button again.</td>
<td>P. 56</td>
</tr>
<tr>
<td>The card is full.</td>
<td>Erase unwanted pictures or insert a new card. Before erasing, download important images to a PC.</td>
<td>P. 101</td>
</tr>
<tr>
<td>The battery ran out of power during shooting or while the images were being written to the card. (The monitor turned off.)</td>
<td>Charge the battery. (Wait until the card access lamp turns off when flashing.)</td>
<td>P. 16</td>
</tr>
<tr>
<td>The memory gauge on the monitor is full.</td>
<td>Wait until there is room in the memory gauge.</td>
<td>P. 13</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>No picture is taken when the shutter button is pressed.</strong></td>
<td>There is a problem with the card. Refer to “Error codes”.</td>
<td>P. 143</td>
</tr>
<tr>
<td><strong>The viewfinder display is not clear.</strong></td>
<td>There is condensation* in the viewfinder. Wait until the camera dries before turning it on again.</td>
<td>—</td>
</tr>
<tr>
<td><strong>The monitor is hard to see.</strong></td>
<td>The brightness is not adjusted properly. Select <img src="image" alt="icon" /> in the MODE MENU and adjust the brightness.</td>
<td>P. 117</td>
</tr>
<tr>
<td></td>
<td>The monitor is exposed to direct sunlight. Block the sunlight with your hand.</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Vertical lines appear on the monitor screen during shooting. Aiming the camera at a bright subject in sunlight may cause vertical lines to appear on the screen. This is not a malfunction.</td>
<td>—</td>
</tr>
<tr>
<td><strong>The date recorded with the image data is wrong.</strong></td>
<td>The date/time is not set. Set the date/time. The clock adjustment is not factory-preset.</td>
<td>P. 24</td>
</tr>
<tr>
<td></td>
<td>The camera has been left with the battery removed. If the camera is left for about 1 day with the battery removed, the date/time setting is canceled. Set the date/time again.</td>
<td>P. 24</td>
</tr>
<tr>
<td><strong>The settings are returned to the factory default settings when the camera is turned off.</strong></td>
<td>ALL RESET is set to ON. Set ALL RESET to OFF in the MODE MENU.</td>
<td>P. 103</td>
</tr>
</tbody>
</table>

*Condensation: When it is cold outside, the water vapor in the air is rapidly cooled and turns to droplets of water. Condensation occurs when the camera is suddenly taken from a cold place into a warm room.*
<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The picture is out of focus.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The subject is too close.</td>
<td>Position the camera more than 0.2 m/0.7 ft. from the subject and take the picture. To take pictures closer than 0.2 m/0.7 ft., use the super macro mode.</td>
<td>P. 63, 64</td>
</tr>
<tr>
<td>Auto focus is not possible.</td>
<td>Use focus lock to focus on the subject and then shoot.</td>
<td>P. 46</td>
</tr>
<tr>
<td>There is condensation* on the lens.</td>
<td>Wait until the camera dries before turning it on again.</td>
<td>—</td>
</tr>
<tr>
<td>The monitor goes off.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The camera is in the sleep mode.</td>
<td>Operate the camera (press the shutter button or the zoom lever).</td>
<td>P. 22</td>
</tr>
<tr>
<td>The power is turned off with the monitor off.</td>
<td>If ALL RESET is set to OFF in the MODE MENU, the camera settings before the power was turned off remain unchanged. Turn on the monitor, and turn off the power.</td>
<td>P. 41, 103</td>
</tr>
<tr>
<td>The flash does not fire.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash is set to the flash off mode 😼.</td>
<td>Select a flash mode other than flash off 😼.</td>
<td>P. 55</td>
</tr>
<tr>
<td>The subject is illuminated.</td>
<td>If you want the flash to fire on a brightly illuminated subject, set the flash to fill-in mode ¶.</td>
<td>P. 55</td>
</tr>
<tr>
<td>DRIVE is set to BKT.</td>
<td>If the flash is set to the red-eye reduction 😁 or Slow synchronization with red-eye reduction 😁 SLOW, the flash does not fire in the BKT mode. Set DRIVE to any mode other than BKT.</td>
<td>P. 68</td>
</tr>
<tr>
<td>The camera is in the 🎥 (movie) mode.</td>
<td>The flash does not fire in the 🎥 mode. Set a different shooting mode.</td>
<td>P. 35</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The flash does not fire.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Super macro mode is set.</td>
<td>The flash does not fire in the super macro mode. Set 📸 to OFF.</td>
<td>P. 64</td>
</tr>
<tr>
<td>Panorama mode is set.</td>
<td>The flash does not fire in the panorama mode. Cancel the panorama mode.</td>
<td>P. 71</td>
</tr>
<tr>
<td>The battery run time is brief.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You are using the camera in a cold environment.</td>
<td>Battery performance deteriorates in low temperatures. Keep the camera warm by putting it inside your coat or clothing.</td>
<td>—</td>
</tr>
<tr>
<td>The remaining battery power is not indicated correctly.</td>
<td>When battery consumption fluctuates greatly, the camera may turn off without displaying the battery warning indicator. Charge the battery.</td>
<td>P. 13,16</td>
</tr>
<tr>
<td>The green and orange lamps on the right of the viewfinder blink simultaneously.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The battery is exhausted.</td>
<td>Charge the battery.</td>
<td>P. 16</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Recorded pictures do not turn out well.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The picture is out of focus.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A subject unsuited to AF was taken.</td>
<td>Use focus lock to focus on the subject and then shoot.</td>
<td>P. 46</td>
</tr>
<tr>
<td>The camera moved when the shutter button was pressed.</td>
<td>Hold the camera correctly and press the shutter button gently.</td>
<td>P. 39</td>
</tr>
<tr>
<td>The flash was set to the flash off mode in a lighting condition requiring use of the flash.</td>
<td>Select a flash mode other than flash off. Camera movement occurs easily with slower shutter speeds. Use a tripod, or set the flash to AUTO.</td>
<td>P. 55</td>
</tr>
<tr>
<td>The lens is dirty.</td>
<td>Clean the lens. Use a commercially available blower blush and then wipe with a lens cleaner to remove dust. Mold may form on the lens surface if the lens is left dirty.</td>
<td>P. 161</td>
</tr>
<tr>
<td>The shutter button was pressed while standing in front of the camera in the self-timer mode.</td>
<td>Press the shutter button while looking into the viewfinder, not while standing in front of the camera.</td>
<td>P. 65</td>
</tr>
<tr>
<td><strong>The picture is too bright.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash was set to the fill-in flash mode .</td>
<td>Select a flash mode other than fill-in flash .</td>
<td>P. 55</td>
</tr>
<tr>
<td>The center of the subject is too dark.</td>
<td>If the center of the subject is too dark, the surrounding area emerges as too bright. Adjust the exposure compensation toward minus (−).</td>
<td>P. 84</td>
</tr>
<tr>
<td>The ISO is at a high setting.</td>
<td>Set the ISO to AUTO or to a low sensitivity: 64.</td>
<td>P. 83</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The picture is too bright</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The aperture value is small in the A (M) mode.</td>
<td>Increase the aperture value. Or set the camera to the P mode.</td>
<td>P. 58</td>
</tr>
<tr>
<td>The shutter speed setting is too slow in the S (M) mode.</td>
<td>Increase the shutter speed or set the camera to the P mode.</td>
<td>P. 59</td>
</tr>
<tr>
<td><strong>The picture is too dark.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash was blocked by your finger.</td>
<td>Hold the camera correctly, keeping your fingers away from the flash.</td>
<td>P. 39</td>
</tr>
<tr>
<td>The subject was out of the working range of the flash.</td>
<td>Shoot within the flash working range.</td>
<td>P. 55</td>
</tr>
<tr>
<td>The flash was set to the flash off mode ②.</td>
<td>Select a flash mode other than flash off ②.</td>
<td>P. 55</td>
</tr>
<tr>
<td>The subject was too small and was backlit.</td>
<td>Set the flash to fill-in mode ⑦, or use the spot metering mode ⑩.</td>
<td>P. 55, 62</td>
</tr>
<tr>
<td>The sequential shooting mode was used.</td>
<td>Higher shutter speeds are used when the sequential shooting mode is selected, which may result in pictures that are darker than usual. Set DRIVE to ④ in the MODE MENU.</td>
<td>P. 68</td>
</tr>
<tr>
<td>The center of the subject is too bright.</td>
<td>If the center of the subject is too bright, the image as a whole emerges darker. Adjust the exposure compensation toward plus (+).</td>
<td>P. 84</td>
</tr>
<tr>
<td>The aperture value setting is too high in the A (M) mode.</td>
<td>Decrease the aperture value or set the camera to the P mode.</td>
<td>P. 58</td>
</tr>
<tr>
<td>The shutter speed setting is too fast in the S (M) mode.</td>
<td>Decrease the shutter speed or set the camera to the P mode.</td>
<td>P. 59</td>
</tr>
<tr>
<td>Possible cause</td>
<td>Corrective action</td>
<td>Ref. Page</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>The colors of pictures look unnatural.</td>
<td></td>
<td>P. 85</td>
</tr>
<tr>
<td>Indoor lighting can affect the picture’s colors.</td>
<td>Set the white balance according to the lighting.</td>
<td></td>
</tr>
<tr>
<td>No white in the picture.</td>
<td>Include something white in the picture, or shoot using the fill-in flash mode.</td>
<td>P. 55</td>
</tr>
<tr>
<td>The white balance setting is wrong.</td>
<td>Adjust the white balance according to the light source.</td>
<td>P. 85</td>
</tr>
<tr>
<td>Part of the picture is too dark.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The lens was partly blocked by your finger or the strap.</td>
<td>Hold the camera correctly, keeping your fingers and the strap away from the lens.</td>
<td>P. 39</td>
</tr>
<tr>
<td>Halation produces unnatural colors in the picture.</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>This may be caused by excessively bright ultraviolet light on the subject, such as sunlight shining through the leaves of trees, window frames in bright light at night, reflection of metal in direct sunlight, etc.</td>
<td>Process the picture using a graphics application (Photoshop, Paint Shop Pro, etc.). For example, after picking up unnatural colors with a syringe tool, etc. you can select color areas, and try color conversion or saturation adjustment. For details, refer to the manual for the graphics application you are using.</td>
<td>—</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pictures you have taken do not appear on the monitor.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The power is off.</td>
<td>Press the (playback) button.</td>
<td>P. 21, 89</td>
</tr>
<tr>
<td>The camera is in the shooting mode.</td>
<td>Close the lens barrier and press the (playback) button.</td>
<td>P. 89</td>
</tr>
<tr>
<td>There are no pictures on the card.</td>
<td>NO PICTURE appears on the monitor. Record pictures.</td>
<td>—</td>
</tr>
<tr>
<td>There is a problem with the card.</td>
<td>Refer to “Error codes”.</td>
<td>P. 143</td>
</tr>
<tr>
<td>The camera is connected to a TV.</td>
<td>The monitor does not function when the AV cable is connected to the camera.</td>
<td>P. 97</td>
</tr>
<tr>
<td><strong>Single-frame erase and all-frame erase cannot be performed.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The pictures are protected.</td>
<td>Display pictures with and press the (protect) button to cancel protection.</td>
<td>P. 100</td>
</tr>
<tr>
<td><strong>No picture is displayed on the TV when connected to the camera.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The video output signal is incorrect.</td>
<td>Set the video output signal according to the region where used.</td>
<td>P. 122</td>
</tr>
<tr>
<td>The TV video signal setting is incorrect.</td>
<td>Set the TV to the video input mode.</td>
<td>P. 97</td>
</tr>
<tr>
<td><strong>The monitor is hard to see.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The brightness is not adjusted properly.</td>
<td>Select in the MODE MENU and adjust the brightness.</td>
<td>P. 117</td>
</tr>
<tr>
<td>The monitor is exposed to direct sunlight.</td>
<td>Block the sunlight with your hand.</td>
<td>—</td>
</tr>
</tbody>
</table>
When the camera is connected to a PC or Printer.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The camera is not recognized by the PC.</strong></td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>The USB driver has not been installed.</td>
<td>It is necessary to install the USB driver for Windows 98/98SE. For how to install, see “DIGITAL CAMERA-PC CONNECTION OPERATION MANUAL” on the CD-ROM.</td>
<td>—</td>
</tr>
<tr>
<td><strong>The camera is not recognized by the printer.</strong></td>
<td></td>
<td>P. 130</td>
</tr>
<tr>
<td>PC was selected on the monitor after connecting to the printer with a USB cable.</td>
<td>Disconnect the USB cable from the camera and start again from the beginning.</td>
<td>—</td>
</tr>
<tr>
<td>The printer does not support PictBridge.</td>
<td>Refer to the printer's instruction manual or contact the manufacturer.</td>
<td>—</td>
</tr>
</tbody>
</table>
## Menu directory

### P/A/S/M/ \( \text{\textcopyright} / / / / / / \) mode

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CAMERA</td>
<td>SCENE(^1)</td>
<td>[ ]</td>
<td>P. 36</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ]</td>
<td>OFF</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ]</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ] [ ]</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ] [ ] [ ]</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DRIVE(^2)</td>
<td>[ ]</td>
<td>P. 68</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ] [ ]</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ] [ ] [ ]</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ] [ ] [ ]</td>
<td>BKT</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>±0.7</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>x3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>±1.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>x5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ISO</td>
<td>AUTO(^3)</td>
<td>P. 83</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>64(^4)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>100</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>200</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>400</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ]</td>
<td>–2</td>
<td>P. 57</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>+2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOISE</td>
<td>OFF</td>
<td>P. 88</td>
</tr>
<tr>
<td></td>
<td></td>
<td>REDUCTION(^5)</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DIGITAL ZOOM(^6)</td>
<td>OFF</td>
<td>P. 52</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FULLTIME AF</td>
<td>OFF</td>
<td>P. 61</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ACCESSORY</td>
<td>OFF</td>
<td>P. 78</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ]</td>
<td>OFF</td>
<td>P. 75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>[ ]</td>
<td>OFF</td>
<td>P. 64</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PANORAMA(^7)</td>
<td>OFF</td>
<td>P. 71</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 IN 1</td>
<td>OFF</td>
<td>P. 73</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FUNCTION</td>
<td>OFF</td>
<td>P. 74</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BLACK&amp;WHITE</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SEPIA</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INFO</td>
<td>OFF</td>
<td>P. 111</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
</tbody>
</table>

\(^1\) : Factory default setting
# Menu directory

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CAMERa</td>
<td></td>
<td>OFF</td>
<td>P. 113</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>PICTuRE</td>
<td></td>
<td></td>
<td>TIFF</td>
<td>P. 79</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2816x2112</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2560x1920</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2272x1704</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2048x1536</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1600x1200</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1280x960</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1024x768</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>640x480</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SHQ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HQ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SQ1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HIGH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2560x1920</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2272x1704</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2048x1536</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1600x1200</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1280x960</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1024x768</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>640x480</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SQ2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2560x1920</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2272x1704</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2048x1536</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1600x1200</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1280x960</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1024x768</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>640x480</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>WB</td>
<td>P. 85</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AUTO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>☀</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>☀</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>☀</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>☀</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SHARPNESS</td>
<td>P. 86</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CONTRAST</td>
<td>P. 87</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CARD</td>
<td>P. 115</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CARD SETUP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>YES</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SETUP</td>
<td>P. 103</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ALL RESET</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PW ON/OFF</td>
<td>P. 120</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SETUP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SCREEN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>VOLUME</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LOW</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HIGH</td>
<td></td>
</tr>
</tbody>
</table>

: Factory default setting
### Menu directory

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>SETUP</td>
<td>REC VIEW</td>
<td>OFF</td>
<td>P. 121</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF</td>
<td>P. 117</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LOW</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HIGH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHUTTER SOUND</td>
<td>OFF</td>
<td>P. 118</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 LOW</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 HIGH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLEEP</td>
<td>30SEC</td>
<td>P. 122</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1MIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3MIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5MIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10MIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MY MODE SETUP</td>
<td>CURRENT</td>
<td>P. 108</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SET</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CANCEL</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RESET</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ALL RESET</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CANCEL</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CUSTOM</td>
<td>P. 110</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>To the CUSTOM screen.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FILE NAME</td>
<td>RESET</td>
<td>P. 123</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AUTO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PIXEL MAPPING</td>
<td></td>
<td>P. 124</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AUTO</td>
<td>P. 117</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PAL</td>
<td>P. 24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC</td>
<td>P. 122</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PAL</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHORT CUT</td>
<td>A</td>
<td>P. 105</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>B</td>
<td></td>
</tr>
</tbody>
</table>

* These can be replaced with other functions using the SHORT CUT setting.

**MONITOR OFF (MONITOR ON)**

---

*1 Not available in the modes other than the P/A/S/M mode.
*2 Not available in the mode.
*3 The factory default setting is set to AUTO in the P/A/S/M mode.
*4 The factory default setting is set to 64 in the A/S/M mode.
*5 Not available in the modes other than the P/A/S/M mode. May not be available depending on the shooting mode (P, A, S, or M) registered in the mode.
*6 Not available in the mode. May not be available depending on the shooting mode (P, A, S, or M) registered in the mode.
*7 Not available in the A/S/M mode. May not be available depending on the shooting mode (P, A, S, or M) registered in the mode.

---

: Factory default setting

---

156
### AUTO mode

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE</td>
<td>OFF</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>P. 63</td>
</tr>
<tr>
<td>ISO</td>
<td>64</td>
<td>P. 83</td>
</tr>
<tr>
<td>ISO</td>
<td>100</td>
<td>P. 83</td>
</tr>
<tr>
<td>ISO</td>
<td>200</td>
<td>P. 83</td>
</tr>
<tr>
<td>ISO</td>
<td>400</td>
<td>P. 83</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
<td>P. 52</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>ON</td>
<td>P. 52</td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>OFF</td>
<td>P. 78</td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>ON</td>
<td>P. 78</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF</td>
<td>P. 74</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>BLACK&amp;WHITE</td>
<td>P. 74</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>SEPIA</td>
<td>P. 74</td>
</tr>
</tbody>
</table>

### mode

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CAMERA</td>
<td>AUTO</td>
<td>OFF</td>
<td>P. 65, 66</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>64</td>
<td>P. 83</td>
<td></td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>100</td>
<td>P. 83</td>
<td></td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>200</td>
<td>P. 83</td>
<td></td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>400</td>
<td>P. 83</td>
<td></td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
<td>P. 52</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>ON</td>
<td>P. 52</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>OFF</td>
<td>P. 78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACCESSORY</td>
<td>ON</td>
<td>P. 78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF</td>
<td>P. 74</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FUNCTION</td>
<td>BLACK&amp;WHITE</td>
<td>P. 74</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FUNCTION</td>
<td>SEPIA</td>
<td>P. 74</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To the next page

---

: Factory default setting
<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>PICTURE</td>
<td></td>
<td>HQ</td>
<td>P. 79</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SQ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SHARPNESS</td>
<td></td>
<td>-2 - ±0 - +2</td>
<td>P. 86</td>
</tr>
<tr>
<td></td>
<td>CONTRAST</td>
<td></td>
<td></td>
<td>P. 87</td>
</tr>
<tr>
<td></td>
<td>CARD</td>
<td></td>
<td>YES</td>
<td>P. 115</td>
</tr>
<tr>
<td></td>
<td>CARD SETUP</td>
<td></td>
<td>NO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SETUP</td>
<td></td>
<td>ALL RESET ON OFF</td>
<td>P. 103</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ENGLISH</td>
<td>P. 26</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FRANCAIS</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DEUTSCH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ESPAÑOL</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ITALIANO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>РУССКИЙ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PORTUGUES</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PW ON/OFF</td>
<td></td>
<td>SCREEN OFF</td>
<td>P. 120</td>
</tr>
<tr>
<td></td>
<td>SETUP</td>
<td></td>
<td>VOLUME LOW HIGH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FILE NAME AUTO</td>
<td>P. 123</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PIXEL MAPPING</td>
<td>P. 124</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>VIDEO OUT NTSC</td>
<td>P. 122</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PAL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WB</td>
<td></td>
<td>OFF ON AUTO</td>
<td>P. 45</td>
</tr>
</tbody>
</table>

: Factory default setting
### mode (still pictures)

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>PLAY</td>
<td>+90°</td>
<td>P. 93</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0°</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>-90°</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDIT</td>
<td></td>
<td>640x480</td>
<td>P. 98</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>320x240</td>
<td>P. 99</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CANCEL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CARD</td>
<td>CARD SETUP</td>
<td>ALL ERASE</td>
<td>P. 102</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FORMAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SETUP</td>
<td>ALL RESET</td>
<td>ON</td>
<td>P. 103</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGLISH</td>
<td>P. 26</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FRANCAIS</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DEUTSCH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ESPAÑOL</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ITALIANO</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PORTUGUES</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PW ON/OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SETUP</td>
<td>SCREEN</td>
<td>OFF</td>
<td>P. 120</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VOLUME</td>
<td>ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LOW</td>
<td>LOW</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>HIGH</td>
<td>HIGH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>VOLUME</td>
<td>OFF</td>
<td>P. 119</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LOW</td>
<td>LOW</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>HIGH</td>
<td>HIGH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC</td>
<td>P. 117</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PAL</td>
<td>P. 24</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>P. 122</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>16</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- : Factory default setting
## mode (movies)

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CARD</td>
<td>CARD SETUP</td>
<td>ALL ERASE</td>
<td>P. 102</td>
</tr>
<tr>
<td></td>
<td>SETUP</td>
<td>ALL RESET</td>
<td>FORMAT</td>
<td>P. 115</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON</td>
<td>P. 103</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ENGLISH</td>
<td>P. 26</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FRANCAIS</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DEUTSCH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ESPAÑOL</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ITALIANO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>РУССКИЙ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PORTUGUES</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PW ON/OFF</td>
<td>SETUP</td>
<td>SCREEN</td>
<td>OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>VOLUME</td>
<td>OFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>LOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>HIGH</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VOLUME</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LOW</td>
<td>P. 117</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HIGH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PAL</td>
<td>P. 122</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MOVIE PLAY</td>
<td>4</td>
<td>P. 91</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>INFO</td>
<td>MOVIE PLAYBACK</td>
<td>INDEX</td>
<td>P. 94</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P. 112</td>
</tr>
</tbody>
</table>

- : Factory default setting
Camera maintenance

● Cleaning the camera

1 Close the lens barrier and turn off the camera.

2 Remove the battery. P. 18
   ● If you are using an AC adapter, unplug the AC adapter from the camera first before removing the plug from the AC outlet.

3 Exterior
   → Wipe gently with a soft cloth. If the camera is very dirty, soak the cloth in mild soapy water and wring well. Wipe the camera with the damp cloth and then dry it with a dry cloth. If you have used the camera at the beach, use a cloth soaked in clean water and well wrung.

   Monitor and viewfinder
   → Wipe gently with a soft cloth.

   Lens
   → Blow dust off the lens with a commercially available blower, then wipe gently with a lens cleaner.

   Card
   → Wipe gently with a soft, dry cloth.

● Storage

● When storing the camera for extended periods, remove the battery and the card, and keep in a cool, dry place that is well ventilated.

● Replace the battery periodically and test camera functions.

Note

• Do not use strong solvents such as benzene or alcohol, or chemically treated cloth.
• Cleaning should be done only after the battery has been removed or the AC adapter has been disconnected.
• Mold may form on the lens surface if the lens is left dirty.
• Avoid leaving the camera in places where chemical products are handled since this may result in corrosion.
How to replace the battery (CR2025) of the remote control device

1. Turn the screw on the bottom of the remote control device counterclockwise to loosen.

2. Turn the remote control device over, and remove the cover. Remove the old battery and insert a new battery (CR2025) with the battery facing up as shown.

3. Replace the cover, turn the remote control device over, and turn the screw on the bottom clockwise to tighten.

Note
- Do not apply excessive force to the remote control device.
- Never heat the remote control device or dispose of it in fire.
- The working temperature range for the remote control device is –10°C to 40°C (14°F to 104°F).
### Specifications

<table>
<thead>
<tr>
<th><strong>Product type</strong></th>
<th>Digital camera (for shooting and displaying)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recording system</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Still</strong></td>
<td>Digital recording, JPEG (in accordance with</td>
</tr>
<tr>
<td></td>
<td>Design rule for Camera File system (DCF)),</td>
</tr>
<tr>
<td></td>
<td>TIFF (non-compression)</td>
</tr>
<tr>
<td><strong>Applicable standards</strong></td>
<td>Exif 2.2, Digital Print Order Format (DPOF),</td>
</tr>
<tr>
<td></td>
<td>PRINT Image Matching II, PictBridge</td>
</tr>
<tr>
<td><strong>Sound with still</strong></td>
<td>Wave format</td>
</tr>
<tr>
<td><strong>pictures</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Movie</strong></td>
<td>QuickTime Motion JPEG support</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>xD-Picture Card, 16 MB to 512 MB</td>
</tr>
<tr>
<td><strong>Recording image</strong></td>
<td></td>
</tr>
<tr>
<td><strong>resolutions</strong></td>
<td>2816 x 2112 pixels (TIFF/SHQ/HQ)</td>
</tr>
<tr>
<td></td>
<td>2560 x 1920 pixels (TIFF/SQ1)</td>
</tr>
<tr>
<td></td>
<td>2272 x 1704 pixels (TIFF/SQ1)</td>
</tr>
<tr>
<td></td>
<td>2048 x 1536 pixels (TIFF/SQ1)</td>
</tr>
<tr>
<td></td>
<td>1600 x 1200 pixels (TIFF/SQ1)</td>
</tr>
<tr>
<td></td>
<td>1280 x 960 pixels (TIFF/SQ2)</td>
</tr>
<tr>
<td></td>
<td>1024 x 768 pixels (TIFF/SQ2)</td>
</tr>
<tr>
<td></td>
<td>640 x 480 pixels (TIFF/SQ2)</td>
</tr>
<tr>
<td><strong>No. of storable pictures</strong></td>
<td>Approx. 1 frame (TIFF: 2816x2112)</td>
</tr>
<tr>
<td>(When a 32 MB card is used/Without sound)</td>
<td>Approx. 7 frames (SHQ: 2816x2112)</td>
</tr>
<tr>
<td></td>
<td>Approx. 21 frames (HQ: 2816x2112)</td>
</tr>
<tr>
<td></td>
<td>Approx. 66 frames (SQ1: 1600x1200 NORMAL)</td>
</tr>
<tr>
<td></td>
<td>Approx. 398 frames (SQ2: 640x480 NORMAL)</td>
</tr>
<tr>
<td><strong>No. of effective pixels</strong></td>
<td>6,070,000 pixels</td>
</tr>
<tr>
<td><strong>Image pickup device</strong></td>
<td>1/1.76&quot; CCD solid-state image pickup</td>
</tr>
<tr>
<td></td>
<td>6,370,000 (gross)</td>
</tr>
<tr>
<td><strong>Lens</strong></td>
<td>Olympus lens 7.8 mm to 23.4 mm, f2.8 to f4.8,</td>
</tr>
<tr>
<td></td>
<td>7 elements in 6 groups (equivalent to 38 mm to</td>
</tr>
<tr>
<td></td>
<td>114 mm lens on 35 mm camera)</td>
</tr>
<tr>
<td><strong>Photometric system</strong></td>
<td>Center-weighted metering system, Spot metering</td>
</tr>
<tr>
<td></td>
<td>system</td>
</tr>
<tr>
<td><strong>Aperture</strong></td>
<td>W : f2.8 to f8.0</td>
</tr>
<tr>
<td></td>
<td>T : f4.8 to f8.0</td>
</tr>
<tr>
<td><strong>Shutter speed</strong></td>
<td>Used with mechanical shutter</td>
</tr>
<tr>
<td><strong>Still</strong></td>
<td>1 to 1/1000 sec. (M mode: 8 to 1/1000 sec.;</td>
</tr>
<tr>
<td></td>
<td>during night scene shooting or when slow</td>
</tr>
<tr>
<td></td>
<td>synchronization is used: 4 to 1/1000 sec.)</td>
</tr>
<tr>
<td></td>
<td>1/30 to 1/8000 sec.</td>
</tr>
<tr>
<td><strong>Movie</strong></td>
<td></td>
</tr>
</tbody>
</table>
## Specifications

| **Shooting range** | Normal: 50 cm to ∞ (1.6 ft to ∞)  
Macro mode: 20 cm (W) to 50 cm (0.7 ft to 1.6 ft)  
Super macro mode: 4 cm (W) to 20 cm (0.1 ft to 0.7 ft) |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Viewfinder</strong></td>
<td>Optical real image viewfinder</td>
</tr>
</tbody>
</table>
| **Monitor**       | 1.8" TFT color LCD display  
Approx. 134,000 pixels                          |
| **Autofocus**     | Dual autofocus (Contrast detection system,  
Passive autofocus system)                        |
| **Outer connector** | DC-IN jack, USB connector (mini-B),  
A/V OUT jack                                      |
| **Automatic calendar** | 2000 up to 2099                               |
| **Operating environment** | Temperature  
0°C to 40°C (32°F to 104°F) (operation)  
–20°C to 60°C (– 4°F to 140°F) (storage)  
Humidity  
30% to 90% (operation)  
10% to 90% (storage) |
| **Power supply**  | Only an Olympus LI-10B/12B lithium-ion battery  
AC adapter specified by Olympus (optional)       |
| **Dimensions**    | 99.5 mm x 58.5 mm x 41.5 mm  
(3.9" x 2.3" x 1.6") (excluding protrusions)    |
| **Weight**        | 194 g (0.4 lb) (without battery/card)            |

**SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT ANY NOTICE OR OBLIGATION ON THE PART OF THE MANUFACTURER.**
**A (Aperture Priority) Mode**
You set the aperture yourself and the camera automatically varies the shutter speed so that the picture is taken with the best exposure.

**AE (Automatic Exposure)**
The camera’s built-in exposure meter automatically sets the exposure. The 3 AE modes available on this camera are P mode, in which the camera selects both the aperture and shutter speed, A mode, in which the user selects the aperture and the camera sets the shutter speed, and S mode, in which the user selects the shutter speed and the camera sets the aperture. In M mode, the user selects both the aperture and the shutter speed.

**Aperture**
The adjustable lens opening which controls the amount of light that enters the camera. The larger the aperture, the shorter the depth of field and the fuzzier the background. The smaller the aperture, the greater the depth of field and the sharper the background. Larger aperture values indicate smaller apertures, and smaller aperture values indicate larger apertures.

**Backlight**
A light source to illuminate the monitor from behind the screen.

**CCD (Charge-Coupled Device)**
This converts light passing through the lens into electrical signals. With this camera, light is picked up and converted into RGB signals to build a single image.

**Contrast Detection Method**
This is used to measure the distance to the subject. The camera determines if the image is focused by the level of contrast in the subject.

**Conventional Photograph**
This refers to images recorded using silver halide (the method for recording images in conventional, non-digital photography). This system is different from that used in still video and digital photography.

**DCF (Design rule for Camera File system)**
A standard for image files by the Japan Electronics and Information Technology Industries Association (JEITA).
DPOF (Digital Print Order Format)
This is for saving desired print settings on digital cameras. By entering which images to print and the number of copies of each, the user can easily have the desired images printed by a printer or print lab that supports the DPOF format.

Dual Auto Focus
An auto focus system that uses two different focus detection systems in combination. This camera uses the CCD’s contrast detection system in combination with the passive autofocus system, nullifying the shortcomings of each system.

EV (Exposure Value)
A system for measuring exposure. EV0 is when the aperture is at F1 and the shutter speed is 1 second. The EV then increases by 1 each time the aperture increases by one F stop or the shutter speed increases by one increment. EV can also be used to indicate brightness and ISO settings.

Exposure
The amount of light used to capture an image. The exposure is determined by the time the shutter is open (shutter speed) and the amount of light that passes through the lens (aperture).

ISO
A method for indicating film speed by the International Organization for Standardization (ISO) (e.g. “ISO100”). Higher ISO values indicate greater sensitivity to light, so images can be exposed even in low-light conditions.

JPEG (Joint Photographic Experts Group)
A compression format for still images. Photographs (images) shot using this camera are recorded onto the card in JPEG format when the Record mode is set to SHQ, HQ, SQ1 or SQ2. By downloading these images to a personal computer, users can edit them using graphics application software or view the images using an Internet web browser.

M (Manual) Mode
The user sets both the aperture and shutter speed.

NTSC (National Television Systems Committee) / PAL (Phase Alternating Line)
Television formats. NTSC is mainly used in Japan, North America and Korea. PAL is mainly used in Europe and China.
P (Program) Mode
Also called Program AE mode. The camera automatically sets the best shutter speed and aperture for the shot.

PictBridge
A standard that allows connection of digital cameras and printers made by different manufacturers and enables direct printing.

Pixels
A pixel is the smallest unit (dot) used to make up an image. Clear large-sized printed images require millions of pixels.

Resolution
The size of an image expressed by the number of pixels that make up the image. For instance, a picture taken in 640 x 480 resolution is the same size as the screen when the monitor setting is 640 x 480. However, if the monitor setting is 1024 x 768, the picture only takes up part of the screen.

S (Shutter Priority) Mode
Also called Shutter Priority AE mode. The user selects the shutter speed and the camera automatically varies the aperture so that the picture is taken with the best exposure.

Sleep Mode
A mode designed to save battery life. The camera automatically enters the sleep mode if you do not operate it for a certain time. To get out of the sleep mode, use any button on the camera (shutter button, arrow pad, etc.).

TIFF (Tagged Image File Format)
A format used for saving highly detailed black and white or color image data. TIFF image files can be handled by software programs for scanners and graphics applications. This camera uses TIFF as an uncompressed image file format.

TFT (Thin-Film Transistor) Color Monitor
A transistor color monitor constructed using thin-film technology.

TTL (Through-The-Lens) System
To help adjust exposure, a light receptor built into the camera directly measures the light passing through the lens.
<table>
<thead>
<tr>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
</tr>
<tr>
<td>168</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>Miscellaneous</td>
</tr>
<tr>
<td>31</td>
</tr>
<tr>
<td>34</td>
</tr>
<tr>
<td>39</td>
</tr>
<tr>
<td>43</td>
</tr>
<tr>
<td>48</td>
</tr>
<tr>
<td>52</td>
</tr>
<tr>
<td>53</td>
</tr>
<tr>
<td>54</td>
</tr>
<tr>
<td>55</td>
</tr>
<tr>
<td>56</td>
</tr>
<tr>
<td>57</td>
</tr>
<tr>
<td>58</td>
</tr>
<tr>
<td>59</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>61</td>
</tr>
<tr>
<td>62</td>
</tr>
<tr>
<td>63</td>
</tr>
<tr>
<td>64</td>
</tr>
<tr>
<td>65</td>
</tr>
<tr>
<td>66</td>
</tr>
<tr>
<td>67</td>
</tr>
<tr>
<td>68</td>
</tr>
<tr>
<td>69</td>
</tr>
<tr>
<td>70</td>
</tr>
<tr>
<td>71</td>
</tr>
<tr>
<td>72</td>
</tr>
<tr>
<td>73</td>
</tr>
<tr>
<td>74</td>
</tr>
<tr>
<td>75</td>
</tr>
<tr>
<td>76</td>
</tr>
<tr>
<td>77</td>
</tr>
<tr>
<td>78</td>
</tr>
<tr>
<td>79</td>
</tr>
<tr>
<td>80</td>
</tr>
<tr>
<td>81</td>
</tr>
<tr>
<td>82</td>
</tr>
<tr>
<td>83</td>
</tr>
<tr>
<td>84</td>
</tr>
<tr>
<td>85</td>
</tr>
<tr>
<td>86</td>
</tr>
<tr>
<td>87</td>
</tr>
<tr>
<td>88</td>
</tr>
<tr>
<td>89</td>
</tr>
<tr>
<td>90</td>
</tr>
<tr>
<td>91</td>
</tr>
<tr>
<td>92</td>
</tr>
<tr>
<td>93</td>
</tr>
<tr>
<td>94</td>
</tr>
<tr>
<td>95</td>
</tr>
<tr>
<td>96</td>
</tr>
<tr>
<td>97</td>
</tr>
<tr>
<td>98</td>
</tr>
<tr>
<td>99</td>
</tr>
<tr>
<td>100</td>
</tr>
<tr>
<td>101</td>
</tr>
<tr>
<td>102</td>
</tr>
<tr>
<td>103</td>
</tr>
<tr>
<td>104</td>
</tr>
<tr>
<td>105</td>
</tr>
<tr>
<td>106</td>
</tr>
<tr>
<td>107</td>
</tr>
<tr>
<td>108</td>
</tr>
<tr>
<td>109</td>
</tr>
<tr>
<td>110</td>
</tr>
<tr>
<td>111</td>
</tr>
<tr>
<td>112</td>
</tr>
<tr>
<td>113</td>
</tr>
<tr>
<td>114</td>
</tr>
<tr>
<td>115</td>
</tr>
<tr>
<td>116</td>
</tr>
<tr>
<td>117</td>
</tr>
<tr>
<td>118</td>
</tr>
<tr>
<td>119</td>
</tr>
<tr>
<td>120</td>
</tr>
<tr>
<td>121</td>
</tr>
<tr>
<td>122</td>
</tr>
<tr>
<td>123</td>
</tr>
<tr>
<td>124</td>
</tr>
<tr>
<td>125</td>
</tr>
<tr>
<td>126</td>
</tr>
<tr>
<td>127</td>
</tr>
<tr>
<td>128</td>
</tr>
<tr>
<td>129</td>
</tr>
<tr>
<td>130</td>
</tr>
<tr>
<td>131</td>
</tr>
<tr>
<td>132</td>
</tr>
<tr>
<td>133</td>
</tr>
<tr>
<td>134</td>
</tr>
<tr>
<td>135</td>
</tr>
<tr>
<td>136</td>
</tr>
<tr>
<td>137</td>
</tr>
<tr>
<td>138</td>
</tr>
<tr>
<td>139</td>
</tr>
<tr>
<td>140</td>
</tr>
<tr>
<td>141</td>
</tr>
<tr>
<td>142</td>
</tr>
<tr>
<td>143</td>
</tr>
<tr>
<td>144</td>
</tr>
<tr>
<td>145</td>
</tr>
<tr>
<td>146</td>
</tr>
<tr>
<td>147</td>
</tr>
<tr>
<td>148</td>
</tr>
<tr>
<td>149</td>
</tr>
<tr>
<td>150</td>
</tr>
<tr>
<td>151</td>
</tr>
<tr>
<td>152</td>
</tr>
<tr>
<td>153</td>
</tr>
<tr>
<td>154</td>
</tr>
<tr>
<td>155</td>
</tr>
<tr>
<td>156</td>
</tr>
<tr>
<td>157</td>
</tr>
<tr>
<td>158</td>
</tr>
<tr>
<td>159</td>
</tr>
<tr>
<td>160</td>
</tr>
<tr>
<td>161</td>
</tr>
<tr>
<td>162</td>
</tr>
<tr>
<td>163</td>
</tr>
<tr>
<td>164</td>
</tr>
<tr>
<td>165</td>
</tr>
<tr>
<td>166</td>
</tr>
<tr>
<td>167</td>
</tr>
<tr>
<td>168</td>
</tr>
</tbody>
</table>
## Index

### G
- Green lamp ............................... 9, 40

### H
- Half press ................................. 40
- HIGH (Record mode) .................... 79
- Histogram display .................... 113
- HQ ................................................ 80

### I
- INDEX ........................................... 96
- Index display .......................... 91
- INFO ........................................... 111
- ISO ............................................... 83

### L
- Landscape +
  - Portrait shooting  ................. 36
- Landscape
  - + Scene shooting  ................. 36
- Language selection  .......... 26
- Lens ................................................ 8
- Lens barrier ............................. 8
- Lithium ion battery ................. 16

### M
- Macro mode shooting  ............... 63
- Manual shooting  ................. 38, 60
- Memory gauge ........................... 13
- Microphone ......................... 8, 75, 77, 98
- MODE MENU ............................... 31
- Mode dial ................................. 8, 35
- MONITOR OFF
  - (MONITOR ON) .......................... 45
- Monitor ................................. 9, 10, 41, 117
- Monitor brightness
  - adjustment .............................. 117
- MOVIE PLAY ........................................... 94
- MOVIE PLAYBACK ......................... 94
- Movie recording ...................... 37, 49
- MY MODE SETUP ......................... 108
- My mode ................................. 37

### N
- Night-Scene shooting ............... 35
- NOISE REDUCTION ....................... 88
- NORMAL (Record mode) ................. 79
- NTSC .................................. 122, 166
- Number of frames in an index
  - display .................................. 91
- Number of storable pictures ........ 80

### O
- OK/Menu button  .......................... 9, 27
- Orange lamp ............................... 9, 40, 55
- Overcast .................................. 85

### P
- PAL ........................................ 122, 166
- PANORAMA .................................... 71
- PictBridge ................................. 129, 167
- Picture rotation  ......................... 93
- PIXEL MAPPING .......................... 124
- Pixels ........................................... 167
- Playback mode .......................... 21, 89
- Playback on a TV ...................... 97
- Portrait shooting  ....................... 97
- Print reservation ....................... 35
- Program shooting  ...................... 37
- Protect ........................................... 100
Index

R
REC VIEW ..................................121
Record mode .............................79
Recording sound .......................98
Recording sound
    with movies ..........................77
Recording sound with
    still pictures ......................75
Red-eye reduction flash ........53
Remaining recording time .49, 81
Remote control ........................66
Remote control receiver ..........66
Resizing ..................................99
Resolution ...............................79, 167

S
SCENE .......................................36
Self-timer ..................................65
Self-timer
    /Remote control lamp ........8, 65, 66
SEPIA ......................................74
Sequential shooting ..................68
SHARPNESS ..............................86
Shooting mode ..........................21, 35
SHORT CUT ...............................105
Shortcut menus ..........................30
SHQ .........................................80
SHUTTER SOUND .......................118
Shutter button ..........................8, 40
Shutter priority shooting S .......38, 59
Shutter speed ..........................59
Single-frame erase ....................101
Single-frame playback ..............89
Single-frame reservation ..........................127
Single-frame shooting ..............68
Slideshow ..................................92
Slow synchronization SLOW ..........54
Slow synchronization with red-eye
    reduction flash SLOW ..............54
Speaker ................................... 8
Sports shooting .......................36
Spot metering ...........................62
SQ1 .........................................80
SQ2 .........................................80
STANDARD ...............................129
Startup/shutdown screen ..........22
Strap .......................................15
Strap eyelet ............................8, 15
Sunlight ..................................85
Super macro shooting ...............64

T
Telephoto T ...............................51
TIFF .......................................80
Top menu .................................27
Tripod socket ...........................9
Tungsten light .........................85

U
Underwater housing .....................78
USB .........................................130
USB cable ................................130
USB connector ..........................9, 130

V
VIDEO OUT ...............................122
Viewfinder ...............................9, 42
VOLUME ....................................119
W
White balance...........................85
Wide-angle W..........................51

X
xD-Picture Card........................17

Z
Zoom lever .......................8, 51, 90, 91
Thank you for purchasing an Olympus digital camera.

This manual provides instructions on how to install the USB driver. To ensure correct installation, refer only to these installation procedures.

DIGITAL CAMERA — PC CONNECTION
OPERATION MANUAL

How to use your PC to get the most from images taken with your digital camera.
Introduction

This manual explains in detail how to connect your Olympus digital camera to a computer. Read it carefully and keep it in a safe place for future reference.

About this manual

- The information contained in this manual may be subject to change without notice. For the latest information on the product, please consult your local Olympus representative.
- The information contained in this manual has been compiled by taking all possible measures to ensure its accuracy. However, if you find any errors or incomplete information, please contact your local Olympus representative.
- It is prohibited by copyright laws to duplicate in part or in whole the information contained in this manual, except for personal use. Reproduction without permission of the copyright owner is prohibited.
- The PC screens shown in this manual may differ slightly from the actual displays on some PC models.

Trademarks

- Microsoft and Windows are registered trademarks of Microsoft Corporation.
- Macintosh is a trademark of Apple Computer Inc.
- All other company and product names are registered trademarks and/or trademarks of their respective owners.
INDEX

Flowchart ........................................ 4

Identifying the OS ................................. 6

Windows (98/Me/2000/XP) ...................... 8

Macintosh (OS 9/X) ................................. 23

Downloading image files using other OS (For other OS users) ....................... 31
Flowchart

By connecting the camera to a computer with the provided USB cable, images on a card can be transferred to the computer. Some OS’s (operating systems) may need a special setup before connecting to the camera for the first time. Follow the chart below.

For details, see the Olympus Corporate Site or phone customer support.

1. Identifying the OS (p.6)
   - Windows 98/98 SE (Second Edition)
   - Windows Me/2000/XP
   - MacOS 9.0 - 9.2/OS X
     * For OS 8.6, see below.

2. Installing the USB driver for Windows 98 (p.9)

3. Connecting the camera to the computer using the provided USB cable
   (Windows p.11, Mac p.24)

4. Confirming the computer recognizes the camera (p.14)

5. Downloading image files
   (Windows p.17, Mac p.26)

6.Disconnecting the USB cable
   (Windows p.20, Mac p.30)

* Even if your computer has a USB connector, data transfer may not function correctly if you are using one of the operating systems listed below or if you have an add-on USB connector (extension card, etc.).

- Windows 95/NT 4.0
- Windows 98/98 SE upgrade from Windows 95
- Mac OS 8.6 or lower (except Mac OS 8.6 equipped with USB MASS Storage Support 1.3.5 installed at the factory)
- Data transfer is not guaranteed on a home-built PC system or PCs with no factory installed OS.
• When connecting the camera to the computer, make sure that there is sufficient remaining battery power. When connected (transmitting) to the computer, the camera does not enter the sleep mode nor will the camera’s power turn off automatically. Depending on the camera model, when the battery power runs out or the internal temperature rises, the camera may stop operating automatically. This could cause the computer to malfunction, and any image data (file) being transmitted may be lost. Be careful when downloading files for a long period of time. Use the AC adapter (optional) when downloading files.

• If you connect or disconnect the AC adapter when the camera is connected to the computer and is running on battery power, it may result in the loss of image data on the card or cause a malfunction in the computer. Before connecting or disconnecting the AC adapter, disconnect the camera from the computer and make sure that the camera is turned off.

• To avoid computer malfunctions, do not turn off the camera when the camera is connected to a computer.

• If the camera is connected to the computer via a USB hub, operation may not be stable if there are any compatibility problems between the computer and the hub. In such cases, do not use the hub and connect the camera directly to the computer.

• You can view images using: graphics applications that support the JPEG file format (Paint Shop Pro, Photoshop, etc.); Internet browsers (Netscape Communicator, Microsoft Internet Explorer, etc.); CAMEDIA Master software; or other software. For details on using commercial graphics applications, refer to their instruction manuals.

• QuickTime is needed for playing back movies. QuickTime is included on the provided software CD.

• If you want to process images, make sure to download them to your computer first. Depending on the software, image files may be destroyed if the images are processed (rotated, etc.) while they are on the card.
Identifying the OS

Identify the OS on your computer before connecting the camera. How to identify the OS depends on the computer.

● Windows

1. Double-click the “My Computer” icon on your desktop.
   When the “My computer” icon is not on your desktop, click “Control Panel” from the “Start” menu.

2. Double-click the “Control Panel” icon.

3. Double-click the “System” icon.

   The way the file icons inside the folder appear may vary depending on your version of Windows. If you don't see the icon you are looking for, click on “view all Control Panel options” on the left of the window.
A System Properties window will appear. Note and record the “System:” information.
Confirm that your system is Windows 98, 98 SE, Me, 2000 Professional or Windows XP, then press “OK” to close the window.

If your OS is Windows 98/98 SE, proceed to “Installing the USB driver for Windows 98” (p.9).
Users running Windows Me/2000/XP p.11
Users running other OS p.31

● Mac OS (Macintosh)

Select “About This Computer” from the Apple menu on the menu bar.
A window appears with the name of the computer’s OS.
Confirm that the OS is OS 9.0-9.2 or OS X.

Users running Mac OS 9/X p.23
Users running other OS p.31
Make sure that:

● Your computer is turned on and Windows is running.
● If you are running any applications, quit them all.
● You are recommended to power the camera using the optional AC adapter. If the battery power runs out while the computer is accessing the card in the camera, the camera will turn off in the middle of the operation and this could destroy image files (data). If you are using batteries, make sure that there is sufficient remaining battery power.

Installing the USB driver for Windows 98 (When using Windows 98/98 SE) .......................................................................................................................... 9
Connecting the camera to the computer ........................................ 11
Confirming the computer recognizes the camera ..................... 14
Confirming the USB driver is installed ........................................ 15
Downloading images to your computer ..................................... 17
Disconnecting the camera from your computer ....................... 20
Installing the USB driver for Windows 98
(When using Windows 98/98 SE)

If your OS is Windows 98/98 SE, you must install the USB driver. Follow the instructions below to install the USB driver in your computer. Once it is fully installed, you do not need to repeat the procedure again.

If your OS is Windows Me/2000/XP, you do not need to install the USB driver. Proceed to “Connecting the camera to the computer” (p.11).

1. Insert the provided software CD into your CD-ROM drive.

2. The Olympus Windows Installer should automatically launch. Click “USB Driver”.
   If the USB driver is already installed in your computer, this option will not appear.
   • This option will not appear if you are using Windows Me/2000/XP.

   If the installer is not automatically launched, select “Run..” on the “Start” menu and then execute “(drive letter):/ Information.exe”.

   The drive letter of the CD-ROM varies depending on the computer.
   To identify the drive letter, double-click “My Computer” on the desktop.
Installing the USB driver for Windows 98 (When using Windows 98/98 SE)

3 Click “Continue”. The installation of the USB driver will start.

4 Click “OK” to restart your computer and the installation is complete.

5 When the computer has restarted, installation is complete. If the Olympus Windows Installer screen appears, click “Close” and remove the CD-ROM from the CD-ROM drive.
Users running Windows 98/98SE need to install the USB drive before connecting the camera to your computer for the first time. (p.9)

1. Some camera models have a “USB” setting in the menu. Make sure that “PC” is selected before connecting. This is not required if your camera does not have this setting. For details on how to operate the menu, refer to your camera’s reference manual.

2. Insert the marked end of the provided USB cable into the USB port on your computer as shown below.

   ![USB cable and computer](image)

   *Note* The location of the USB port varies depending on the computer. For details, refer to your computer’s manual.

3. After making sure that the camera is turned off, connect the end of the USB cable to the USB connector on the camera.

   ![USB cable and camera](image)

   The location of the USB connector or multi connector varies depending on the camera model. Refer to the camera manual for details.
Connecting the camera to the computer

4 Turn the camera on in ➔ (playback) mode.
   • Most cameras with a lens barrier turn on automatically in Step 3, with the exception of some models which require you to press the ☻ (monitor) button or ➔ button.

5 When the screen shown right appears on the monitor in Step 4, use the arrow pad to select “PC” and press the OK button.

6 The computer recognizes the camera as a new device.
   • Depending on the camera model, when you connect the camera to the computer, the lamp on the right of the viewfinder or the self-timer lamp may light.

When you connect the camera to the computer for the first time, the computer automatically recognizes the camera. Click “OK” when the message saying that the installation is completed appears. The computer recognizes the camera as a “Removable Disk”.

Windows
Connecting the camera to the computer

- **Windows XP**
  You can download image files from the camera easily. Select “Copy pictures to folder on my computer using Microsoft Scanner and Camera Wizard”, then follow the on-screen instructions. You may also select “take no action” to bypass the Microsoft Scanner and Camera Wizard. You may then use a more advanced image viewing/editing program such as Olympus CAMEDIA Master software. For detailed instructions on downloading, refer to the CAMEDIA Master software user’s guide.

> When the camera is connected to the computer, none of the camera buttons are functional.

Caution
Confirming the computer recognizes the camera

1. Double-click the “My Computer” icon on the desktop.  
   For users running Windows XP, click “My Computer” from the “Start” menu.

2. Make sure the “Removable Disk” icon appears in the window.  
   There may already be other “Removable Disk” icons for other devices, such as a removable media drive or USB SmartMedia Reader/Writer. In this case, the digital camera is recognized as another “Removable Disk”.  
   If you cannot find the icon, the camera and computer are not connected properly. Turn the camera off, disconnect the camera from the computer and connect again, or proceed to “Confirming the USB driver is installed” (p.15) to make sure that the USB driver is fully installed.
Confirming the USB driver is installed

If the computer does not recognize the camera as a Removable Disk, follow the procedure below to check whether the USB driver has been fully installed.

1. Open “My Computer” and double-click the “Control Panel” icon. For users running Windows XP, open “Control Panel” from the “Start” menu.

2. Double-click the “System” icon.

3. The System window will appear. Click the “Device Manager” tab.
Confirming the USB driver is installed

4 Confirm that “OLYMPUS Digital Camera” is in the “Universal Serial Bus Controller” category.

If you cannot find the “OLYMPUS Digital Camera”, turn the camera off, disconnect the camera from the computer and start again. Users running Windows 98/98 SE start again from “Confirming the USB driver is installed”, and Users running Windows Me/2000/XP start from “Connecting the camera to the computer”.

If the USB driver was successfully installed, you can find the following in the “Device Manager”.

– the name of the camera you have connected listed under “Disk drives”
– “OLYMPUS Digital Camera” listed as one of the items in the “Universal Serial Bus Controller” category
1. Double-click the “My Computer” icon on the desktop. For users running Windows XP, click “Control Panel” from the “Start” menu.

2. Double-click the “Removable Disk” icon.

A new “Removable Disk” icon appears when the camera is connected to the computer, as the digital camera is recognized as a “Removable Disk”.

If an error message appears when you double-click the icon, there may be a problem with one of the following:

- the camera’s power source (the AC adapter is not properly connected or the battery power is low)
  Make sure that the AC adapter is correctly connected or that the batteries are not running low.
- the card (there is no card in the camera or there is a problem with the card)
  Check that you can play back pictures stored on the card on the monitor of your digital camera.

3. Double-click the “Dcim” folder.
4 Double-click the “100olymp” folder.  
Image files (JPEG files) with file names such as “P1010001.jpg” are displayed.

Note

• The camera automatically assigns folder names and file names according to the following rules.

<table>
<thead>
<tr>
<th>Folder name</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Example)</td>
<td>(Example)</td>
</tr>
<tr>
<td>100olymp</td>
<td>P1010001.jpg</td>
</tr>
<tr>
<td>Serial number</td>
<td>Month / Day / Serial number</td>
</tr>
</tbody>
</table>

• Serial numbers of image files run from 0001 to 9999.
• Serial numbers of folders run from 100 to 999.
• When file number 9999 is reached, a new folder is created and assigned the next number.
• Months January through September are expressed by the numbers 1 through 9, October by the letter A, November by B and December by C.

5 Double-click the “My Documents” icon on the desktop.
If you cannot find the icon on the desktop, select “Explorer” on the Start menu and double-click the “My Documents” icon.
The “My Documents” window is displayed.

6 Drag & drop the image you want to save in the computer (in this case, P1010012.jpg) to the “My Documents” window.

The image is saved in the computer (in My Documents folder).
- To select all files, choose Edit > Select all.

When the image file has been downloaded to the computer, you can view images by double-clicking the image files downloaded to your computer. The files will be opened in the default image viewer of the operating system. If you want to view the image a different size or process it, you will need to open the image with software that supports JPEG or TIFF images files, such as Paint Shop Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while the image is being copied. Never open the card cover on the camera, load or remove the batteries, or connect or disconnect the AC adapter while the lamp is blinking as the image files may be destroyed.
Disconnecting the camera from your computer

If your OS is Windows Me/2000, proceed to “Windows Me/2000/XP” (p.21).

● Windows 98

1. Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. The lamps and their location vary depending on the model. Refer to your camera’s reference manual.

2. Double-click the “My Computer” icon and right-click the “Removable Disk” to display the menu.

3. Click “Eject” on the menu.
4 Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking.
Depending on the camera model, the green lamp may light or lamps that were lit while the camera was connected to the computer may go off. If the lamp is not flashing, then the cable can be removed.

5 Remove the USB cable from the camera.

6 Remove the USB cable from your computer.

Windows Me/2000/XP

1 Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking.
The lamps and their location vary depending on the model. Refer to your camera’s reference manual.
Disconnecting the camera from your computer

2 Click the “Unplug or Eject Hardware” icon on the task bar.
The message saying that the drive has been stopped appears.

3 Click on the message.
The “Unplug or Eject Hardware” window appears.

4 When a message appears, click “OK”.

5 Remove the USB cable from the camera.

6 Remove the USB cable from your computer.

Caution

If the window returns the following message when you click “Unplug or Eject Hardware”, first make sure that no image data is being downloaded from the camera, and then remove the USB cable.
Make sure that:

- Your computer is turned on and Mac OS is running.
- If you are running any applications, quit them all.
- You are recommended to power the camera using the optional AC adapter.

If the battery power runs out while the computer is accessing the card in the camera, the camera will turn off in the middle of the operation and this could destroy image files (data). If you are using batteries, make sure that there is sufficient remaining battery power.

If you are running Mac OS X, the connection to the computer and downloading the image data are verified. Restrictions such as the following may occur due to the OS.

- The image file properties are not displayed correctly.
- Images in the camera cannot be opened without first downloading them. etc.

For more details, visit the Olympus web site.

Connecting the camera to the computer ................................. 24
Downloading images to your computer................................... 26
Disconnecting the camera from your computer ..................... 30
Connecting the camera to the computer

1 Some camera models have a “USB” setting in the menu. Make sure that “PC” is selected before connecting. This is not required if your camera does not have this setting. For details on how to operate the menu, refer to your camera’s reference manual.

2 Insert the marked end of the USB cable into the USB port on your computer as shown below.

3 After making sure that the camera is turned off, connect the end of the USB cable to the USB connector on the camera.

The location of the USB port varies depending on the computer. For details, refer to your computer’s manual.
Connecting the camera to the computer

4 Turn the camera on in (playback) mode.
   • Most cameras with a lens barrier turn on automatically in Step 3, with the exception of some models which require you to press the (monitor) button or button.

5 When the screen shown right appears on the monitor in Step 4, use the arrow pad to select “PC” and press the OK button.

6 The computer recognizes the camera as a new device.
   • Depending on the camera model, when you connect the camera to the computer, the lamp on the right of the viewfinder or the self-timer lamp may light.

The computer recognizes the camera automatically and an “Untitled” icon appears on the desktop. If you cannot find this icon, turn off the camera and connect again.

   Mac OS X
   When the computer has recognized the camera, the Apple Image Capture software automatically launches. p.29

Caution

- When the camera is connected to the computer, none of the camera buttons are functional.
Macintosh

Downloading images to your computer

Mac OS 9

You can download images from the camera and save them in your computer (in this case, in the Hard Disk).

1 Double-click the “Untitled” icon displayed on the desktop when the camera is connected to the computer.

If you cannot find this icon, or if an error message appears when you double-click the icon, there may be a problem with one of the following:

① the camera’s power source (the AC adapter is not properly connected or the battery power is low)
② the card (there is no card in the camera or there is a problem with the card)
   Check that you can play back pictures on the monitor of your camera.
③ the USB cable (the camera is not properly connected to the computer by the USB cable).
④ Apple “File Exchange” extension is not enabled.
   • Please refer to your Apple operating system manual for instructions on how to enable this extension.

2 Double-click the “Dcim” folder.

3 Double-click the “100OLYMP” folder.
Image files (JPEG files) with files
names such as “P1010001.JPG” are
displayed.

The camera automatically assigns folder names and file names according
to the following rules.

Folder name  
(Example)  

100OLYMP  
Serial number

File name  
(Example)  

P1010001.jpg  
Month / Day / Serial number

• Serial numbers of image files run from 0001 to 9999.
• Serial numbers of folders run from 100 to 999.
• When file number 9999 is reached, a new folder is created and assigned
  the next number.
• Months January through September are expressed by the numbers 1
  through 9, October by the letter A, November by B and December by C.

4 Double-click the “Macintosh HD”
icon on the desktop.
5 Drag & drop the image you want to save in the computer (in this case, P1010012.JPG) to the “Hard Disk” window.

The image is saved in the computer (in the Hard disk).
• To select all images, click Edit > Select all.

When the image file has been copied to the computer, you can view images by double-clicking the image files in the “Hard Disk” folder. The files will be opened in the default image viewer of the operating system. If you want to view the image a different size or process it, you will need to open the image with software that supports JPEG or TIFF images files, such as Paint Shop Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while the image is being copied. Never open the card cover on the camera, load or remove the batteries, or connect or disconnect the AC adapter while the lamp is blinking as the image files may be destroyed.
Mac OS X

Malfunctions such as the following may occur due to the OS.
• If the camera is not connected correctly, a malfunction occurs in the computer.
• Date and time information of image files is not accurately displayed.
• If the card cover of the camera is opened while connecting to the computer, the “untitled” icon does not disappear from the desktop, etc.

When the computer has recognized the camera, the Apple Image Capture software dialog appears.

1. From the “Download To” menu, select a destination folder.

2. To download all images, click “Download All”.
   To selectively download images, click “Download Some” and highlight the desired images.
   The images are transferred from the camera to your computer.

**Note**
If you are operating Mac OS X and you want to download images using the same procedure as for Mac OS 9, select “File > Close” and exit the Apple Image Capture software. At this time, the camera is indicated as “unlabeled”.

**Caution**
If you use the Apple Image Capture software, images downloaded to your computer and transferred back to a card may not play back on the camera or may have other problems.
1. Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. The lamps and their location vary depending on the model. Refer to your camera’s reference manual.

2. Drag the “untitled” icon on the desktop to “Trash”.

3. Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. Depending on the camera model, the green lamp may light or lamps that were lit while the camera was connected to the computer may go off. If the lamp is not flashing, then the cable can be removed.

4. Remove the USB cable from the camera.

5. Remove the USB cable from your computer.
Users running other OS cannot connect the camera directly to a computer.

- **Windows 95**
- **Windows NT**
- **Mac OS before OS 9**

For an OS listed above, you can download images directly to your computer using an optional floppy disk adapter or PC card adapter.

For details, see the Olympus Corporate Site or phone customer support.

**Does your computer have a USB interface?**

Is there a port marked on your computer?

- **No**
- **Yes**

Is your OS one of the following?
- Windows 98
- Windows 2000
- Windows Me
- Windows XP
- Mac OS 9/X

**Yes**

Connect the camera directly to your computer using the provided USB cable.

**Use the optional USB reader/writer.**

*Certain card readers may not be compatible with Mac OS X. Check the Olympus website for the most up-to-date compatibility information.*

**No**

Consult your nearest Olympus representative.

**Does your computer have a built-in PC card slot?**

- **No**
- **Yes**

**Yes**

Use the optional PC card adapter*.

*Not supported by Windows NT 4.0 or lower